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Introduction to the User Guide

This user guide gives instructions on using the Reporting System for the following:

e Accessing summative assessment data for the OST, AASCD, OELPA and Alt-OELPA administrations.

e Accessing non-summative assessment data for the OELPS and RA administrations and for teacher-
authored tests.

e Scoring non-summative assessments for the RA administration and for teacher-authored tests.

It includes the following sections:

e Navigate Reports

e Set Up Reports to Suit Your Needs

e Export and Print Data

e Score ltems
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Navigate Reports

This section explains how to navigate your reports for your assessments.

Understand Which Students Appear in Your Reports

e Teachers can view data for all students in their classes (rosters) who have completed assessments.
e School-level users can view data for all students in their schools who have completed assessments.

e District-level users can view data for all students in their districts who have completed assessments.

Start Viewing Reports

Use the Dashboard Generator Page

When you log in to the Reporting System, the Dashboard Generator page appears (Figure 1). The
controls on the left let you select from the groups of tests that have been processed for the school year.
Typically, you may choose test types, subjects within the test types, and grades within the subjects.

Test types may include Field Authored, which comprises tests created in the Assessment Authoring
system. The Field Authored type does not list subjects or grades as subcategories. If a field-authored test
opportunity requires hand scoring for any item, it will not appear in reports until educators have
provided scores for all items in the hand scoring module.

Figure 1. Dashboard Generator Page

Dashboard Selector » Dashboard Generator

These are 2023-2024 school year reports. Change the reporting time period.

i il ith? { 1) ? e
Which test groups would you like to start with? Looking for a specific student? $22 Features & Tools
P Get the results of a student by entering their
student ID Reporting Options ~
AL A a Change Reporting Time
v [ Mathematics Ehites Bident i Search Period
v [ Science Download & Print A
v O social Studies g3 Dovnload srudemt
'} Results
A [0 Checkpoints Test Options A
v [ ELA = - =] SetStudent Setting on
B ' Manage Test Reasons 258 ttem View
~ [ Mathematics
fpsns Roster Settings A~
cience
v O Social Studiss + addroster © viewedit Roster

O Upload Rost
A [ OELPS 1, Upload Roster

~ [ English Proficiency

[J Field Authored

To the right of the dashboard generation controls are some other useful features. The Looking for a
specific student? section allows you to use student ID to view all that student’s test results. The Features
& Tools menu appears on the right side of this page and in reports and offers multiple features that are
described elsewhere in this guide.

If the Dashboard Generator shows a message saying there are no data, that means no test opportunities
are available for this school year.
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1. Optional: To change the test groups listed in the Dashboard Generator, change the reporting time
period.

2. Select the tests you want to view, expanding the test groups as needed.

3. Optional: To save your selections, mark the checkbox Make these my default selections. These
selections will be set in the Dashboard Generator whenever you log in. You can change the defaults
at any time.

4. Optional: To view results for teacher-authored tests, mark the checkbox Field Authored.

5. Click Go to Dashboard. The dashboard appears, displaying any data available for your selections.

Use the Dashboard to View Aggregate Test Results

All users can view the standard dashboard (Figure 2). It displays aggregation cards representing test
groups.

Each aggregation card displays the test group name, a list of grades, the number of students who took
tests in the group, the date of the test last taken, and a performance distribution bar displaying both
percentages and student counts below it. You may sometimes see the message “Data cannot be
aggregated together for this group of tests” instead of the performance distribution bar for tests that do
not report performance distribution or that use different sets of performance levels. Test group cards
are sorted by date last taken.

Clicking the @ button beside the performance distribution bar displays a legend with more information
about performance levels.

Figure 2. Dashboard

Dashboard Selector > Dashboard Generator > Dashboard Enter Student ID Q

S Performance Distribution, By Test Group: DEMO District, 2023-2024
Fites | Fitereq By Test Reasons: All Test Reasons | Sorted By: Date Last Taken 333 Features & Tools

,_=_ OELPS English Proficiency Checkpoints Mathematics Reporting Options ~
e d Grades Tested: 1,2,3,4,5,6,8,9,12,22 d GradesTested:3,4,5,6,7,8,10,11,129 ﬁ Change Reporting Time
TestsTaken:48  Date Last Taken: 07/24/2023 Tests Taken: 33 Date Last Taken: 07/24/2023 Period
=) 5333371 P Download & Print ~
est
wwwwww percent % 46% 10% Data cannot be aggregated together for this group of tests al Dcwr‘\\oad Student @ Print
count 2 5 4 Results
Test Options ~
= Set Student Setting on
- . . Manage TestReasons  [¥=) !
Benchmark Mathematics Benchmark Science Eé o Q Item View
d Grades Tested: 3,4,5,6,7,8,10,11,12,9 d Grades Tested: 5,8,10,11,12,9 Roster Settings ~
Tests Taken: 29 Date Last Taken: 07/24/2023 Tests Taken: 22 Date Last Taken: 07/24/2023
- Add Roster (@ ViewEdit Roster
/] /A

Percent 90% 3% 7% Percent 95% 5% 4 Upload Roster
) —
Count 2 12 Count 2 1

If a message appears saying “There are no assessments to display,” you may not have any students who
have taken tests in your selected test groups in the selected time period. You can change the reporting
time period. If you are a teacher, you may also be able to view more students’ data by managing your

classes (rosters).

To change the test groups and test reasons that appear, use the Filters panel on the left. For more
information on filtering, see Set Up Reports to Suit Your Needs. You can also backtrack to the Dashboard
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Generator using the link in the path at the upper-left corner and change your test group
selections there.

View More Detailed Data on a Particular Test Group

To view more detailed data for a particular test group, click the name of the group. The Performance on
Tests report appears. It is filtered to display only the test group you selected.

In the Performance on Tests report, teachers see two tables, as in Figure 3:

The My Assessments table, listing all the assessments in the filtered test group or groups.

The My Students table, listing all your students who took the assessments.

Figure 3. Teacher View: Performance on Tests Report

Select Role > Dashboard Generator » Dashboard > Performance on Tests

—=
—
-
Filters

)
Test
Groups

Test
Reasons

Rosters

- My Assessments

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023

Filtered By Rosters: All Roster | Test Reasons:All Test Reasons |

Assessment Name Test Group Test Grade
&‘ Algebra | v 0hi$‘:SIS::ale 10
o, | Integrated Mathematics Il v Ohi.?sszme 10
&, | Integrated Mathematics | ~ Ohi;fﬂs;ale 10

A My Students

Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: AllRoster | Test Reasons:All Test Reasons |

Student Name

TechLN, Tech-FN

PCB7532, PCB7532

Student

Test Reason Count

Summer 2023 3
(0sT)

Summer 2023
(osT)

Summer 2023 2
(0sT)

Student ID
DEM049905

DEM039240

Enter Student ID Q

3t1 Features & Tools

Average P Date Last
Score Performance Distribution Taken ¥
bz o
658 @ | pucent 100% 05/00/2023
Count 2
bz o
633 @ P o 05/08/2023
Count 2z
V2 o
658 @ Percent 100% 05/08/2023
Count 2
Rows perpage: 3 o 6 ltems: 1 of2 »
Most Recent Assessment Date Taken
Algebra | 05/09/2023
Algebra | 05/09/2023
Rows per page: |2 © 11 Items: 1 ofe »

District- and school-level users see just one table, as in Figure 3. Like the first table on the teacher
Performance on Tests report, this table lists all the assessments in the test group.
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Figure 4. School-Level User View: Performance on Tests Report

Dashooard Selector » Dashboard Generator > Dashboard > Performance on Tests Enter student {93
-_TE Average Score and F & Di t: DEMO District, 2023-2024
Fers Fiitered By School: All Schoois | Test Reasons: A1
Assessment Name Test Group Test Grade Test Reason Student Count Average Score Date Last Taken -
&, | American History - 1945 Present Checkpoint 1 ~ Checkpaints 10 Pre-Instruction 2 313 @ 07/21/2023
b, | American Government : Principles and Structure Checkpoint 2 ~ Checkpaints 10 Pre-Instruction 1 43 @ 07/21/2023
& & met overnment : Principles and Structure Checkngint 1 3 Checkpoints 10 Pre-Instruction 1 412 @ 07/21/2023
&, | American Government : Ohlo/Policy/Econemy_Checkpoint 2 v Checkpaints 10 Pre-Instruction 1 511 @ 07/21/2023
&, | American Government . Onio/Policy/Fconomy Checkpoint 1 v Checkpoints 10 Pre-instruction 1 AN ] 07/21/2023
&, | Ametican History - Skills and Documents Checkpoint 2 v Checkpoints 10 Pre-instruction 1 ve @ 07/20/2023
&, | American History - Skills and Documents Checkpaint 1 v Checkpaints 10 Pre-Instruction 1 e @ 07/20/2023
&, | American History - 1945-Present Checkpoint 2 v Checkpaints 10 Pre-Instruction 1 612 @ 072012023
&, | American History - 1877-1945 Checkpoint 1 ~ Checkpaints 10 Pre-nstruction 1 211 @ 07/20/2023
b, | American History - 1877-1645 Checkpoint 2 ~ Checkpaints 10 Pre-Instruction 1 "z @ 07/20/2023
Rows per page: 10 14 nems 1 ofz )

For each test, the assessments table (Figure 4) shows the test group, grade, test reason (the name of the
test window of a summative assessment or a category assigned to a non-summative assessment),
number of students who took the test, average score, performance distribution, and date the test was
last taken.

You can use the filters to view a different set of assessments. For more information on filtering, refer to
Set Up Reports to Suit Your Needs.

If a message appears saying “There are no assessments to display” or “There are no students to display”,
there may be no assessments taken in your current reporting time period or you may have filtered out
all data.

Teachers: View Student-Level Data for All Your Students

The Performance by Student tab of the My Students’ Performance on Test report displays test results
for each of your students across classes (rosters). In order to see the results for all your students, follow
the instructions below.

1. Generate a dashboard and click a test group name.
2. Click a test name in the assessments table at the top of the page.

3. Inthe My Students’ Performance on Test report that appears, select the Performance by Student
tab, as in Figure 5. You will see results listing all your students. The first few rows also show
aggregate performance data for your state, district, school, and total students.
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Figure 5. My Students’ Performance on Test Report: Performance by Student Tab

—F
- —
=
Fitters.

(s)

‘Standards

Select Role > Dashboard Generator > Dashboard > Performance on Tests > My

on Test

Performance by Roster || Performance by Student

Enter Student ID

i1t Features & Tools

Q

Score, Performance and Points Earned on Geometry (Spring 2023 (OST)) of All Rosters, by Student and Reporting Category:,
Filtered By Rosters: All Rosters | Test Reasons: Spring 2023 (OST) | Reporting Time Period: 06/01/2023 | Standards Keys = 1

Student 4 StudentID
State
District
School
My Students
Demo, Student CsC200401

[e10L €3

Scale Score

693 @
619 @
619 @
619 @

619 @

Raw Score

n/a

Performance

Percent  33%  18% 19% 14% 9%
Count 478K  21.8K23.2K17.3K1.4K

Percent 100%
Count 3

1596 9} PALLIOKI SIUSPNIS YDIYM U0 Swiall ¢ @)

A o

Percent 100%
Count [

b2 o

Percent 100%
Count 1

Limited

Rows per page:

1SIOM 3U) PAULIOYII SIUBPNIS UDIUM UO SWall § @)

10 ¢

2022-2023

sapu0 @
e

Jooid pue asuanibuoy
Buoseay pue buljepon @

1 ltems:

Aungeqoid @

Anawouobli] 3 Auepuis @

of 1

To see which students performed best, click the score or Performance columns to sort them.

You can view your students’ performance in each area of the test by clicking the reporting category
section bars to expand them, as shown in Figure 6.

Figure 6. My Students’ Performance on Test Report: Performance by Student Tab with Expanded

Reporting Category Section

Select Role > D

Generator > Dashboard > Performance on Tests > My

on Test

Performance by Roster || Performance by Student

Enter Student ID

:3: Features & Tools

Q

Score, Performance and Points Earned on Geometry (Spring 2023 (OST)) of All Rosters, by Student and Reporting Category:, 2022-2023
Filtered By Rosters: All Rosters | Test Reasons: Spring 2023 (OST) | Reporting Time Period: 06/01/2023 | Standards Keys -

Student 4 | Student ID
State
District
School
My Students
Demo, Student CSC200401

el @

1598 3} PAULIOLR SIUSPNIS YDIYM UO SWBY S @)

1SI0M 33 PaWWIOLA SIUSPNIS YOIYM UO SWaYI G @)

s3I0 €3

Raw Score

n/a

n/a

Performance

Percemt  40% 3% 20%

Count 48.9K 479K 247K
Percent 100%

Count &
Percent 100%

Count 6
Percemt 100%

Count 1

Below Proficient

Rows per page:

1pt

077

1

10 o

7 14
1pt 2pt
0.33 0.86

0 0.75

0 0.75

0 n/a

0 n/a

1 ltems:

19
1pt

0.18

n/a

Item Numbers, Max Points and Pc

26

1

0.69

pt

G

spuoday a1pBIADN



Reporting System User Guide

School-Level Users: View Student-Level Data for All Your Students

You can follow the same procedure as in Teachers: View Student-Level Data for All Your Students to
view the Performance by Student tab of the School Performance on Test report.

View Test Results for Classes (Rosters) on a Particular Test

You can view a list of classes (rosters) that took a particular test, and you can also view the test results
for a particular class.

Access Test Results for All Your Classes (Rosters)

The Performance by Roster tab (Figure 7) displays test results for each class (roster). To view this tab,
follow the instructions for your user role below.

Teachers and school-level users:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. Either the My Students’ Performance on Test or the
School Performance on Test report appears, depending on your role. It is open to the Performance
by Roster tab.

District-level users can view all classes (rosters) in a school. To do so, follow these instructions:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A page of district test results appears, listing schools
within the district.

3. Click a school name. The School Performance on Test report appears, open to the Performance by
Roster tab.
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The report shown in Figure 7 displays a list of your classes (rosters) and each class’s performance. The
first few rows also show aggregate performance data for your state, district, school, and total students.

Figure 7. My Students’ Performance on Test Report: Performance by Roster Tab

Select Role > D Generator > Dashboard > Performance on Tests > My on Test Enter Student ID CL

-k
3= 12
== Performance by Roster || Performance by Student iti Features & Tools

Filters

m Average Score, Performance Distribution and Average Points Earned on Algebra | (Summer 2023 (OST)), by Roster and Reporting Category: 2022-2023

Ea

Standards Filtered By Rosters: All Roster | Test nmer 2023 (0ST) | Keys @l
we+ o I ¢ 2 0 0 0 o
= o v m oz oz Q@
8 § 5 8§ 38 5 ¢
= St =z P2 = e 2
es @ & 5 5 & z
SIGED Completion RECTS Performance Distribution ctcet S ] » = = v
Count R Scale Score Proficient B E = =
ate = B 2 |\=
5 3 Dz Z
o | o I
@y 2 2 @
g S
= : 2
State n/a n/a n/a n/a ;. ;. < §
= - =
@ @ F
=N o b
S g 2
) ] 3 3 =
District 1 637 @ Percent 100% 0% e 2 g‘
Count 1 § % g
K -
0 5 & F
School 1 637 @ | percem oa%) 0%
Count n
bz o
My Students 3 658 @ Percent 100% 0%
Count 3
L
Roster1 3 9% (3/32) 658 @ | percem 50%) 0%
Count 3
Rows per page: 10 = 1 ltems: 1 of1

Determine Which Classes (Rosters) Performed Well on This Assessment
To find which classes performed best on the test, do either of these things (Figure 8):

e C(Click the score column header to sort by score and look for rosters with high average scores.
e Look at the bars in the Performance Distribution column to see where the percentage of
students at or above proficient is high.
Determine Which Classes (Rosters) Had the Highest Test Completion Rates

To see which classes had the highest test completion rate, click the Test Completion Rate column header
to sort the column (Figure 8).
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Determine How Well Classes (Rosters) Performed in Each Area on the Test

For tests with reporting category sections, you can compare the performance of your students in each
area of the test. Click each vertical section bar to expand or collapse it. In this example (Figure 8), you
can view average score and a performance distribution bar for each class (roster) under the reporting
category Listening.

Figure 8. My Students’ Performance on Test Report: Performance by Roster Tab with Expanded
Reporting Category Section

Select Role > D » Dashboard > Performance on Tests > My Per on Test Enter Student ID Q
Performance by Roster || Performance by Student i1 Features & Tools

Average Score, Performance Distribution and Average Points Earned on Grade 6 OELPS (2022-2023 (OELPS)), by Roster and Reporting Category: 2022-2023

Filtered By Rosters: All Roster | Test Reasons: 2022-2023 (OELPS) |
Roster M _ _
—

|210.
Buluaisi Q

Buipeay @
Bupieads @
Bunum @

student Test Percent
Completion Performance Distribution Determined Performance Distribution
Ccount :
Rate Proficient
State n/a n/a n/a n/a
r
- s | o Va7 o
District 7 Parcent 71% 29% 0% Percant 7% 145 1%
Count 3 2 Count 5 101
o} Vzzz7 o
School 1 Percent 100% 0% Percant 100%
Count 1 Count 1
° b o
My Students 1 Percent 100% 0% Percent 100%
Count. 1 Count 1
o bz o

Demo Roster A 1 100% (1/1) | percent 1005 0% Percent 100%
1 Gount 1

Rows per page: 10 = 1 ltems: 1 of 1

View and Interpret Writing Dimension Measures

Test results for some assessments may also include a Writing Dimensions section to the right of the
expandable sections in the report table. You can expand it by clicking the vertical bar, just as with the
reporting category sections. This section helps you understand how students performed on different
aspects of writing.

The Writing Dimensions section (Figure 9) contains the following under the Essay header:

e Essay type. For example, Informative/Explanatory, Opinion, and Argumentative.

e  Writing dimension within the essay type, as listed in item rubrics. For example, Purpose, Focus, and
Organization; Evidence and Elaboration; and Conventions of Standard English.

- Point value. A sub-column for each possible item point value for the writing dimension.
Each point value sub-column displays the percentage and number of students who earned
that number of points.

For each dimension, the lowest . and highest & point values are sometimes highlighted
and marked with arrow icons in the rows with the highest percentages. This allows you to
quickly identify groups of students who are performing well and those who may need
additional support.
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Note that highlighting and arrow icons do not appear where they are not useful. A report
containing only one row of data does not have them, and neither does a row in which the
percentages are “n/a” or are all the same.

Figure 9. School Performance on Test Report with Expanded Writing Dimensions Section

Dashboard Selector > Dashboard Generator » » on Tests » District Test Enter Student ID Q
-_TE Average Score and Performance Distribution for Grade 7 English Language Arts Benchmark Tests (OH_RRA_22_23), by School and Reporting Category: DEW Training Demo District, 23 Features & Tools
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G e © © © © © © o [ i
J4 o @ s =
g g g i E LH Essay @
sls|3|c g
= = 8 3 3 Argumentative
= 2 3 ¢ ]
BN 5 B2 g
g 28§ a Conventions Elaboration Purpose Conventions
()
4] 2 § opt ipt | 2pt opt | 1pt  2pt | 3pt  4pt | Opt  ipt | 2pt  3pt | 4pt  Opt gt 2pt
Z @
State % g nsa nia n/a nia n/a na n/a na nja n/a n/a na n/a na nja nja
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To learn about the highlighting and arrow icons, click the more information button @ in the Essay
header. A legend expands, as in Figure 10.

Figure 10. School Performance on Test Report with Expanded Writing Dimensions Section and
Expanded Legend

Dashboard Selector > Dashboard Generator » Dashboard > Tests > District Test > Test Enter Student ID Q

= .
= Performance by Roster || Performance by Student Features & Tools

[:] Average Score, Performance Distribution and Average Points Earned on Grade 7 English Language Arts Benchmark Tests (OH_RRA_22_23), by Roster and Reporting Category: DEW Training Demo School-B
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Access Test Results for an Individual Class (Roster)

Prior sections explained how to access test results for all your classes (rosters). To view results for one
specific class, click the name of a class that appears in the first column of the report. The class results
listed by student appear (Figure 11).

Figure 11. School-Level User View: Roster Performance on Test Report

Dashboard Generator > Dashboard > P n Tests > My Students’ P onTest > Roster Test Enter Student ID Q
Score, Performance and Points Earned on Kindergarten OELPS (2023-2024 (OELPS)) of _2_CRS_8604-check2-teproctored, by Student and Reporting Category: 2023-2024 22 Features & Tools
Filterec By Rosters: All Roster | Test Reasons:2023-2024 (OELPS) |

e+ e o [ © © © ©
g g 7 % =
g i £ 3 2
= =
Proficiency Status a8 @ |3
State n/a
B o
District Percent  40% s0%
. 2 B
e
School Percent  40% 80%
Cou 2 :
77777777778
My Students Parcant 100
. )
LN.EN DEMO002860 Emerging

Rows perpage: 10 1 tems 1 of1
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Determine How Well Students in Your Class (Roster) Performed in Each Area of
the Test

You can compare the performance of your students in each area of the test using the reporting category
sections, as shown in Figure 12. Click the vertical section bar to expand each section.

Figure 12. School-Level User View: Roster Performance on Test Report with Expanded Reporting
Category Section

Select Role » Dashboard Generator » Dashboard » Performance on Tests » School Performance on Test » Roster Performance on Test Enter Student ID Q

Score, Performance and Points Earned on Grade 5 Mathematics (2022-2023 (AASCD)) of (students not in any roster), by Student and Reporting
Category: 2022-2023 ===
Filtered By Rosters: All Roster | Test Reasons: 2022-2023 (AASCD) |

= oo [ © o [ @
g g 3 g
E £ g -
g @
Scale Score Performance E 3 Performance &1
State n/a n/a n/a
. o e ] e
District 293 @ Percent 83% 4%13% Percent 5% 10%15%
Count 20 13 Count 15 2 3
o g | o
School 293 @ Percant 3% %13 Percent 5% 10%15%
Count 20 13 Count 15 2 3
o s | e
My Students 279 @ Percent 86% 5% 9% Percent 79% 11%115
Count bt 12 Count 15 z oz
LN, FN DEM002479 278 @ Limited Below Proficient
LN, FN DEM002480 122 @ Limited Below Proficient
LN, FN DEMO02482 122 @ Limited Below Proficient
LN, FN DEMOQ02549 g0z @ Advanced Above Proficient
Rows perpage: 4 © 22 ltems: 1 of6 »

School- and District-Level Users: View Test Results for a School on a
Particular Test

You can view test results for all the students in a school on a particular test. This gives you a high-level
look at how the school is performing.

Access Test Results for a School

School-level users:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. The School Performance on Test report appears.

12
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District-level users:
1. Generate a dashboard and click a test group name.
2. Click a test name in the table of assessments. A table listing test results by school appears.

3. Click the name of the school for which you would like to see results. The test results for the school
appear.

Note that district-level users can also access the test results from a school directly from the
Performance on Tests report by first filtering by school.

The Performance by Roster tab is open by default, as in Figure 13.

Figure 13. School Performance on Test Report: Performance by Roster Tab
Dashboard Selector > Dashboard Generator > Dashboard > Performance on Tests » District Performance on Test > School Test Enter Student ID Q

=k
k= i3% Features & Tools
m: Performance by Roster || Performance by Student

[@) Average Score, Performance Distribution and Average Points Earned on Grade 5 Science Benchmark Test (Pre-Instruction), by Roster and Reporting Category: DEMO School 20232024
sﬁ:d:,d; Filtered By School: All Schools | Test Reasons: Pre-Instruction | Standards Keys @l
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Determine Which Classes (Rosters) Performed Well on This Assessment

In the Performance by Roster tab, look at the Performance Distribution column and click the header of
the score column to sort by score (Figure 13). Rosters with a high average scale score and with a high
percentage of students performing at or above proficient in the performance distribution bar performed
well on the assessment. If certain classes (rosters) performed consistently well, you could use them as a
model for the classes with lower performance.

District-Level Users: View Test Results for a District on a Particular Test

You can view test results for a district on a particular test. This gives you a high-level view of how the
district is performing.

13
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Access Test Results for a District

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. The District Performance on Test report appears,
listing schools in the district (Figure 14).

Figure 14. District Performance on Test Report

Dashboard Selector > Dashboard Generalor > Dashboard > Performance on Tesis > District Test Enter Student 1D Q
Average Score and Performance Distribution for Grade 4 OELPS (2023-2024 (OELPS}), by School and Reporting Category: DEMO District, 2023-2024 42 Features & Tools
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Determine Which Schools in the District Performed Well on This Assessment

Look at the score column and/or Performance Distribution column and click the column header to sort
by it (Figure 15).

Determine Which Schools in the District Performed in Each Area of the Test

Click the vertical section bars to expand the reporting category sections as in Figure 15).

Figure 15. District Performance on Test Report with Expanded Reporting Category Section

Dashboard Generator > Dashboard > Performance on Tests > District. on Test Enter Student ID Q

Average Score and Performance Distribution for Grade 3 English Language Arts (2022-2023 (AASCD)), by School and Reporting Category: 212 Features & Tools
DEMO District, 2022-2023 —
Filtered By School: All Schools | Test Reasons: 2022-2023 (AASCD) |
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View Test Results Broken Down by Demographic Sub-Groups

You can use the Breakdown By button in the Features & Tools menu (Figure 16) to compare
performance between different demographic sub-groups. This button is available for most aggregate
test results.
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View Test Results Broken Down by Demographic Sub-Groups

1. Click Breakdown By in the Features & Tools menu. The Breakdown Attributes window opens.

Figure 16. My Students' Performance on Test Report: Performance by Student Tab: Breakdown
Attributes Window

Breakdown Attributes

Select up to three options

English Learner (EL) Enrolled Grade

Ethnicity ] Gender

[ Gifted and Talented [JIEP

[ Primary Disability [ Student's Migrant Status

[] Include unspecified values

2. Select up to three student demographic categories.

There is also an Include unspecified values checkbox, explained below:

e Some students who complete tests do not have specific demographic information in the Test
Information Distribution Engine (TIDE). These students are considered to have unspecified
values.

e To include data for these students, mark the checkbox.

3. Click Apply.

Data for each sub-group selected are displayed in the report (Figure 17).

15
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Figure 17. Demographic Breakdown of a District Performance on Test Report

Dashboard Generator > Dashboard » Performance on Tests > District Performance on Test > Breakdown Enter Student ID Q
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View Test Results for a Particular Demographic Sub-Group or Combination

When viewing test results broken down by sub-groups, go to the row for the demographic combination
you want to view and click the view button in the View Details column on the left (Figure 17).

A window opens, displaying detailed results for that combination. The report table is now laid out the
same way as the original report before you viewed it broken down by sub-groups (Figure 18).

Figure 18. Demographic Combination Breakdown Window (from District Performance on Test Report)

Breakdown of Grade 3 Mathematics Benchmark Test
Breakdown of Grade 3 Mathematics Benchmark Test (Pre-Instruction), by Enrolled Grade: 01 and Gender: Female: DEMO District, 2023-2024
Filtered By School: All Schools | Test Reasons: Pre-Instruction | Standards Keys [l
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At the top of the report table are filter menus for each demographic category you chose. To change the
demographic combination displayed, use the filters to select the demographic sub-groups you want to
see and click Apply. The new combination is displayed.

You can use this window to get an in-depth look at specific groups of students. For example, you may
want to determine which classes (rosters) have the highest-performing girls in the first grade.

16
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Track Student Performance Over Time

You can view your students’ performance over time across multiple related assessments or across
multiple test opportunities of a single assessment. This lets you see how students’ performance has
improved or declined.

When available, each Longitudinal Report displays performance data for one of the following:

e A group of students who have completed every assessment available in the report. If you are a
district- or school-level user, note that 70% of students must have taken all the related assessments
in order for you to generate a Longitudinal Report. Teachers have the option of adjusting the pool of
students, tests, and test reasons.

e Anindividual student (Figure 19).

Figure 19. Longitudinal Report Window: Summative Report for a Single Student
with Multiple Reporting Categories

Longitudinal Report
Longitudinal report of Score and Performance on Grade 8 English Language Arts: LN, FN, 2021-2022 TE Filters v } [ S Print ]
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£

17

spuoday a1pBIADN




Reporting System User Guide

Access a Longitudinal Report Comparing Related Assessments

If the student(s) in your test results have completed multiple related assessments, the Build
Longitudinal Report button allows you to access a Longitudinal Report in the reports for any of those
assessments. If they haven’t done so, then no Longitudinal Report is available.

e Click the Build Longitudinal Report button in the Features & Tools menu.

e The Longitudinal Report window appears. Depending on your role, the test types, and the number
of students in the report, it may display a report options page rather than the Longitudinal Report
itself. The contents of this page depend on your role and the number of students.

e Teachers only: If the test results you’re looking at are for multiple students, a table appears with
a column for each test (Figure 20). This table does not appear if you’re looking at an individual
student.

e A sub-column appears for each test reason (a category of test or, for a summative, a test
window).

e The cells in the columns display checkmarks «* to indicate which students completed which
test/test reason combinations.

Figure 20. Teacher View: Longitudinal Report Window: Detailed Report Options Page

Longitudinal Report
[ — Mark the checkboxes for the tests you wish to compare, and then click Generate Report. The Longitudinal Report will only show data for students who
. completed every test you chose to include (the students highlighted in the table below).

Students Selected: 18

Test Grade 3 English Language Arts Benchmark Tests Grade 4 English Language Arts Benchmark Tests Grade 7 English Language Arts Benchmark Tests
Test Reason ®Spring 2021 Spring 2022 Spring 2023

LN-RDLdata, FN Y4 v

(DFMONAS32)

LN-RDLdata, FN v v v

(DFMONRS33)

LN-RDLdata, FN v v

(DFMONR534)

LN-RDLdata, FN v v v

(DFMONAS35)

LN-RDLdata, FN v

(DFMONRS36)

LN-RDLdata, FN v v v

(DFMONRS37)

LN-RDLdata, FN v v v

(NDFMO0R538)

e Mark the checkbox for each test/test reason combination you wish to include in the report.
Mark the Test Reason checkbox on the left to include all or clear it to remove all. The test
opportunities that will be included are highlighted in yellow.

e If you're viewing report options, click Generate Report at the top of the window to view the

Longitudinal Report. (You can modify your selections and regenerate the report later using the
Change Selections button.)

18
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View Students’ Overall Performance on These Assessments Over Time

Look at the graph in the upper-left corner of the Longitudinal Report (Figure 21). It shows the scores or
performance levels of the student(s) each time they took the test(s).

Score data are plotted along a line.

Figure 21. Longitudinal Report Window: Summative Report for a Group of Students
with Multiple Reporting Categories

Longitudinal Report
Longitudinal report of Score and Performance on Grade 7 English Language Arts Benchmark Tests: Selected Students, 2022 [ '~ Change Selections ] l £ Filters v ] [ S Print l
Filtered By Test Reasons: Al Test Reasons School Year: All School Years Reporting Date: 07/26/2023 -
Overall Score Reading Informational Text Reading Literary Text Writing
850
7
800 . g
U 4 7
¢ ? ?
©- / i / & @
.. | | [ [
& F A E &
3 o o s
o R R - N N N N N N N
e e o IS © o ©
- I P Y P P

Performance level data are shown either the same way or, for multiple students, in performance
distribution bars.

Mouse over the data points in a line graph or the sections in a bar to get more information.

Alternatively, in the table at the bottom of the report, look at the Overall section.

Switch Between Score Data and Performance Level Data

When a graph offers both score and performance level data, a toggle bar appears at the top of it. Click
the toggle to switch. You may want to do this if you find performance level data easier to read or if you
prefer the precision of score data. Sometimes a test includes only one type of data.

View Students’ Performance in Different Areas Over Time

Look at the reporting category graphs to the right of the overall performance graph or look at the
expandable reporting category sections in the table at the bottom. Here, you can see at a glance how
students are improving or declining in each area, and you can compare their trajectories in

different areas.
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Distinguish Different Types of Tests in the Graphs

A symbol appears on each data point. When multiple test types are present, refer to the legend
immediately below the graphs to find out which symbols correspond to which types.

Modify the Test Groupings You Have Selected

If you generated the report from the report options page, click the Change Selections button in the
upper-right corner of the window. The report options page reappears, allowing you to change your
selections and, if you are a teacher viewing multiple students, your selection of tests and test reasons as
well. Click Generate Report again.

Filter Test Opportunities to Show Some and Not Others
You may want to filter a Longitudinal Report in order to focus on some test opportunities and not
others.

Note that filtering tests may affect the set of students whose data are included in the report.

1. Open the Filters menu at the upper-right corner and select the filter options you prefer from the
drop-down lists.

e You may want to filter by a particular school year or years. Note that years are not calendar
years. “2023” refers to the 2023-2024 school year. By default, Longitudinal Reports show data
for all years.

e Longitudinal Reports can show student performance from a time when the students were not
yet associated with you. For example, if you are a seventh-grade teacher, you can use these
reports to view your current students’ performance on last year’s sixth-grade tests.

e [f the report includes non-summative assessments, you may wish to filter by a test reason (a
category of test), which means excluding all other test reasons from the data. For example, you
may want to narrow the report down to show only tests taken in the spring. For summative
assessments, test reasons are the same as test windows and are not useful.

e Finally, you may find that certain individual tests are less relevant than others. In that case, you
can use the Test Label options to deselect the names of the tests you don’t want to view.

2. Click Apply.

3. Optional: To revert all filters to their defaults, open the Filters menu again and click Clear Filters.
Click Apply.

A row of filter details appears below the report header, showing the test reasons and school years
included in the report.

View a Cross-Sectional Report

When the Cross-Sectional Report is available, you can view an institution’s performance, irrespective of
enrolled students, for a test family across multiple test reasons. Here, an institution can refer to either a
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teacher, a school, or a district. This report helps you understand how the institution’s performance has
improved or declined across student populations.

Unlike the Longitudinal Report, the Cross-Sectional Report does not track a particular set of students.
The set of students may vary across test reasons, depending on which ones belonged to your institution
and took the tests at the time.

e Ateacher can view a report for all their students.

e Aschool-level user can view a report for their school.

e Adistrict-level user can view a report for their district or any school within it.

Access a Cross-Sectional Report for an Institution and Test Family

When viewing either a My Students’, a School, or a District Performance on Test Report for a test that
has a Cross-Sectional Report available, you can access the report using the Build Cross-Sectional Report
button in the Features & Tools menu.

1. Click Build Cross-Sectional Report in the Features & Tools menu. The Cross-Sectional Report
window opens, displaying report options (Figure 22).

Figure 22. Cross-Sectional Report Window: Report Options Page

Cross-Sectional Report

Generate Report Mark up to three checkboxes for the test reasons you wish to compare, and then click Generate Report.

A~ 2023 -2024
Fall 2023 (OST)
A 2022 -2023
Fall 2022 (OST)
Spring 2023 (0ST)
Summer 2023 (OST)
A 2021 -2022

Fall 2021 (OST)

2. From the list of school years and test reasons, select up to three test reasons you wish to compare.

3. Click Generate Report. The report appears (Figure 23), displaying data for the test family to which
the test belongs.

View the Institution’s Overall Performance on This Test Family Over Time

Look at the graph in the upper-left corner of the Cross-Sectional Report (Figure 23). It shows the scores
or performance levels of the institution for each test reason.
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Figure 23. Cross-Sectional Report Window (Scrolled to Top)

Cross-Sectional Report

Cross-Sectional Report of Score and Performance on Algebra | by School and
Reporting Category:DEMO District, 2023-2024, 2022-2023, 2021-2022
Filtered by Test Reasons: Fall 2023 (OST), Fall 2022 (OST), Fall 2021 (0ST)
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A\ Overall and Reporting Category Level Performance

Performance Levels School Year & Test Reason

Score data are plotted along a line. Performance level data are shown in performance distribution bars.
Hover over the data points in a line graph or the sections in a bar to get more information.

Alternatively, in the first table at the bottom of the report (Figure 24), look at the Overall section.
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Figure 24. Cross-Sectional Report Window (Scrolled Down)

Cross-Sectional Report
#\ Overall and Reporting Category Level Performance
Performance Levels School Year & Test Reason

2021 - 2022 2022 - 2023 2023 -2024

Fall 2021 (OST) | Fall 2022 (OST) | Fall 2023 (OST)

@I Overall

Average Score 627 @ 630 @ 652 @

%Limited 100% 100% 100%
%Basic 0% 0% 0%
%Proficient 0% 0% 0%
%aticcomplished 0% 0% 0%
%Advanced 0% 0% 0%

@' Functions

%Below Proficient 100% 100% 100%
%Mear Proficient 0% 0% 0%
%Above Proficient 0% 0% 0%

Q Modeling and Reasoning

Switch Between Score Data and Performance Level Data

When a graph offers both score data and performance level data, a toggle bar appears at the top of it.
Click the toggle to switch between data. You may want to do this if you find performance level data
easier to read, or if you prefer the precision of score data. Sometimes tests include only one type of
data.

Modify the Test Reasons You Have Selected

Click the Change Selections button in the upper-right corner of the window. The report options page
reappears, allowing you to change your selection of test reasons. Click Generate Report again.

View Test Results for Individual Students

You can find out how well an individual student understands the material covered on a specific
completed assessment. You can also view a report for all the assessments a student has taken.

How to Access Test Results for an Individual Student on a Particular Test

Teachers and school-level users:
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1. Generate a dashboard and click a test group name.
2. Click a test name in the table of assessments. A page of test results appears.
3. Select the Performance by Student tab.

4. Click the name of an individual student in the report. The Student Performance on Test report
appears (Figure 25).

District-level users:

4. Generate a dashboard and click a test group name.

5. Click a test name in the table of assessments. A page of test results by school appears.
6. Click a school name. The School Performance on Test report appears.

7. Perform the same steps as teachers and school-level users, starting at step 3.

Figure 25. School-Level User View: Student Performance on Test Report

Dashboard Selector > Dashboard Generator > Dashboard » Performance on Tests > District Performance on Test > School Performance on Test
> Student Performance on Test

—_ . . .
== Score, Performance and Points Earned on English Language Arts Il ADT (Adult Tester Fall 2023) of DEMO School, by Student and Reporting 122 Features & Tools
Fiers Category: 2023-2024

Filtered By School: All Schools | Test Reasons: Adult Tester Fall 2023 | Standards Keys ]

Enter Student ID Q

B e e o I © © @ ©
Standar
= 2 = 5
" HAE
5N = g
s @ @
Scale Score Raw Score Performance Met Competency Score 3 g Z
o a
= =
sz a
g2 =
7
=
ENENE o
State 682 @ nfa Percent  41%  36% 15% 7% 1% n/a
Count 30 26 m s 1
. Wz o
District 622 @ n/a Percent 100% n/a
Count 2
WA o
School 622 @ n/a Percent 100% n/a
Count 2
LN, FN DEM002262 630 @ 5 Limited No
Rows per page: 10 o 1 Items: 1 of1

Depending on the test, you can view the student’s performance in each area of the test using the
reporting category sections (or Total Items section) and the Writing Dimensions section, which you can
click to expand.
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View a Report for All the Assessments a Student Has Completed Over Time

The Student Portfolio Report allows you to view all the assessments an individual student has completed
over time. This is useful for viewing performance on tests that have multiple opportunities and for non-
summative tests that were administered multiple times throughout the year.

To access this report, enter the student's SSID in the search field in the upper-right corner and click the
search button. (When viewing the Dashboard Generator and data are available, the same field appears
to the right of the dashboard generation controls.) The Student Portfolio Report appears (Figure 26).

Teachers can also access this report from the Performance on Tests report by going to the My Students
table below the main assessments table and clicking a student’s name.

Figure 26. Student Portfolio Report

Select Role » D: > Dashboard » Student Portfolio Enter Student ID O\
—F . - Online- . ass
-_|': Score and Performance, by Assessment and Test Reason: 0ST-Online-MOCK FN, 2022-2023 131 Features & Tools
Filters.

Student Date
= Assessment Name Test Group Test Grade Test Reason Count Score Performance Taken ¥
= Ohio’s State Spring 2023
Groups Grade 8 Mathematics v Tests 8 (0sT) 1 633 Limited 03/14/2023
Grade 8 English Language Arts v Oh'?:sfsta'e 8 Sp'('ggsémg 1 586 Limited 03/09/2023
Schaol
Year

Rows per page: 99 2 ltems: 1 of 1

To view individual test results for this student, click a test name.

Use the Student Portfolio Report to View Only the Tests You Are Interested In

You can temporarily filter which tests you want to see in the Student Portfolio Report. You may want to
do this, for example, if you are an ELA teacher and you don’t want to see a student’s math scores. By
default, the data for those math assessments appear in the report, but you can exclude them.

1. Inthe Filters panel on the left side of the Student Portfolio Report, click the Test Groups button. The
Filters panel expands (Figure 27).

Figure 27. Student Portfolio Report with Expanded Filters Panel

Ohio's State Tests
[] Spr21 Released ltems
[[] Field Authored

Select Role > Dashboard Generator > Dashboard > Student Portfolio Enter Student ID O\
y e - OST-Online- .
Filters = Score and Performance, by Assessment and Test Reason: 0ST-Online-MOCK FN, 2022-2023 111 Features & Tools
= Test Test Test Student Date
E:-;- ~ TestGroups Assessment Name Group Grade Reason Count Score Performance Taken ¥
v [ AascD e N
. 0Ohio's State Spring 2023 N
v O AdutTesters Grade 8 Mathematics v Tests 8 ©sT) 1 633 Limited 03/14/2023
v [ AtOELPA s P
© W) Comm iﬁfe B English | anguage v Oh'$§sfst“'e 8 5"';'(1)95%'23 1 586 Limited 03/09/2023
w [] Checkpoints
v [ oePA Rows per page: 99 2 tems: 1 of1
w~ [ oELPS
v
v

A School Year

2022-2023 v

Clear Filters

Apply
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2. Mark as many selections as you like in the Test Group section of the Filters panel. Tests are
organized by test type, subject, and grade.

3. Click Apply. The Student Portfolio Report updates to show only data for those tests.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

View a Student’s Performance on Tests Taken in a Previous School Year or Years

If there are multiple years of data for a student, the Student Portfolio Report can look back at previous

years. This gives you a high-level look at the student’s progress. Student Portfolio Reports can show

student performance from a time when the students were not yet associated with you. For example, if
you are a seventh-grade teacher, you can use these reports to view a current student’s performance on

last year’s sixth-grade tests.

1. On the left side of the page, click the School Year button. The Filters panel expands.

2. Under School Year, select a year or years (Figure 28).

Figure 28. Student Portfolio Report

Select Role > Dashboard Generator > Dashboard > Student Portfolio

Filters

~ Test Groups

)

~ 8chool Year
2022-2023
2022-2023
[J 2021-2022
[J 2020-2021
[J 2017-2018

Clear Filters

Apply

3. Click Apply.

Assessment Name

Grade 8 Mathematics

Grade 8 English Language
Arts

To switch back to the current year:

1. Open the Filters panel again.

2. Click Clear Filters.

3. Click Apply.

v

v

Test

Group Grade

Ohio’s State
Tests

Ohio's State
Tests
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Test

8

8

Score and Performance, by Assessment and Test Reason: 0ST-Online-MOCK FN, 2022-2023

Test Student s
Reason Count core
Spring 2023
(0ST) 1 633
Spring 2023
(0ST) 1 586

Rows per page: 99

Enter Student ID Q

i1 Features & Tools

Date

Performance Taken ¥

Limited 03/14/2023

Limited 03/09/2023

2 ltems: 1 of1
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Access Item-Level Data

Two types of item-level data are available: item scores and item responses. The secure Ohio’s State
Tests have item scores only.

Reports for the non-secure, non-summative Benchmark and Checkpoint tests and teacher-authored
tests include the following:

e [tem-level data

e Access to the items themselves

e Access to student responses to the items

View Item Scores

To expand sections containing item data, click the vertical section bars as in Figure 29.

Figure 29. School Performance on Test Report: Performance by Roster Tab with Expanded Reporting
Category Section

Select Role > Dashboard Generator > Dashboard > Performance on Tests > School Performance on Test Enter Student ID Q

—F
2= e
_': Performance by Roster || Performance by Student iii Features & Tools

m Average Score, Performance Distribution and Average Points Earned on American Government (Fall 2022 (OST)), by Roster and Reporting Category: DEMO School 2022-2023
Stendards | Filtered By Rosters: All Roster | Test Reasons:Fall 2022 (OST) | Standards Keys I

Roster 4 Teacher [ BB R <]
4 @ o 3
SN =
=3 %z tem Numbers and Points Earned
& @ 5
e o @ istributi
g- g g Performance Distribution 1 5 7 15 16 21 22 2 25 2
§ § 5 1pt 1pt 1pt 1pt 1pt 2pt 1pt 1pt 1pt 1
@ & §
& & &
3 3
State g | & n/a n/a n/a n/a n/a n/a n/a n/a n/a n/a n
g
g g
i o ©
District 2 2 Persent P - 0.6 038 0.29 0.67 0.43 05 0.45 0.6 0.44 0
E Count s 2 3
§ 5
a 9 o
School — = TS 0.6 038 | 029 067 | 043 0.5 0.45 0.6 044 | 0
Count 15 z 3
e )
(students not in any roster) Percent 75% 10% 15% 0.6 0.38 0.29 0.67 0.43 0.5 0.45 0.6 0.44 0.
Count 15 o3
Rows per page: 10 1 tems: 1 of1
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Find Out Which Items Students Performed on the Best or Struggled with the Most

Look in the sections 5 Items on Which Students Performed the Best and 5 Items on Which Students
Performed the Worst (Figure 30). You can click the vertical section bars to expand them, just like other
sections.

Figure 30. School Performance on Test Report: Performance by Roster Tab with Expanded 5 ltems on
Which Students Performed the Best and Worst Sections

Select Role > D Generator > D > Performance on Tests > School on Test Enter Student ID Q

—F

2= 75
- Performance by Roster || Performance by Student iii Features & Tools

Filters

I_?] Average Score, Performance Distribution and Average Points Earned on American Government (Fall 2022 (OST)), by Roster and Reporting Category: DEMO School 2022-2023
Sanduds | Fitered By Rosters: All Roster | Test Reasons:Fall 2022 (0ST) | Standards Keys [

Roster ] Teacher (] € 5 items on which Students Performed the @ o0
g o T o =
£ = g2 3
2 g Item Numbers, Max Points and Points Earned '3" Item Numbers, Max Points and Points Eamed = L =2
@ 3 E- -
E 5 258
z 1 15 20 24 7 | 2| 12 26 28 29 72 2 8
S ES s @ &
= 1pt 1pt 2pt 1pt 1pt =3 1pt 1pt 1pt 1pt 1pt 3 B @
4 ] g 2 g
= E &3 |08
3 ] @
State & nfa n/a n/a n/a n/a i n/a na n/a na n/a
g g
g El
z 3
District a 0.6 0.67 1.4 0.6 0.75 o 017 0.22 014 0.25 014
7 gz
= =
@
4 g
School 0.6 0.67 1.4 0.6 0.75 017 0.22 0.14 0.25 0.14
(students not in any roster \G,ﬁ 0.67 14 06 0.75 017 0.22 0.14 0.25 0.14,
Rows per page: 10 © 1 Items: 1 of1
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View Standards for Each Iltem

In a report displaying item-level data, you can view the standard or standards to which each item is
aligned. This allows you to determine at a glance what the item measures.

To show and hide item standards, click the Standards Keys toggle B in the row of filter details
below the report table heading. Under each item number appears a standard key or list of standard keys
(Figure 31). Note that this toggle does not affect printouts or exports, which always include the standard
keys when they include item-level data.

Figure 31. School Performance on Test Report: Performance by Student Tab with Expanded Reporting
Category Section

Select Role > Dashboard Generator > Dashboard > Performance on Tests > School Performance on Test Enter Student ID q

Performance by Roster || Performance by Student iii Features & Tools

n Score, Performance and Points Earned on American Government (Fall 2022 (OST)) of All Rosters, by Student and Reporting Category: DEMO School, 2022-2023
Sndude | Filtered By Rosters: All Roster | Test Reasons:Fall2022 (0ST) | Standards Keys [l

wt s 0 0 © 0 o
ol
g 8 @ §5 &
3 3 2 %
2 2 5 3
= ENE N 4 6
= = § S RawScoe Performance
5 g - AGCIGOV.17 o AGCIGOV.20 o ’
28 2 | 8 §
E|l5|& | 2 1pt 1pt
g 5
]
& @
State 8 & n/a n/a n/a n/a
g g
3 3
: 1 ] o
District 5 7 n/a Percent 7% 0% 15% 0.5 0.57 @
© = Count 1 2 3
g
Rl
(]
school nja r— = oRaE 05 0.57
Caunt 15 2 3
LN.EN DEMO02806 3 Below Proficient 0 0
LN.EN DEMO02809 3 Below Proficient n/a n/a
Rows per page: 2 © 20 Items: 1 of10

Click the more information buttons beside the standard keys to view legends displaying the full text of
each cluster (category of standards) and each standard, as in Figure 32. This full text is not included in
printouts or exports.

Figure 32. District Performance on Test Report with Expanded Reporting Category Section and
Expanded Legend

Dashhoard Generator > Dashboard > Performance on Tests > District on Test Enter Student ID Q
-k P : B . . .
2= Average Score and Performance Distribution for Grade 5 Science (Spring 2023 (0ST)), by School and Reporting Category: DEMO District, 2022-2023 13 Features & Tools
Fikers Filtered By School: All Schools | Test 2023 (0ST) | -
ST
- Flale g
‘Standards i g o g
EE @
@ o 2
o |5 B N 3 5 7 10
3| 2|8 Performance Distribution
5__ 5 ESS|2.5 o ESS[1.5 o ESS(1.5 [ ESS|1.5
=
2 1 2pt 1p
? ] Content Strand: ESS: Earth and Space
=3 z Science @
State 2 g n/a M| Content Statement: ESS|1.5: The solar n/a
@
) system includes the sun and all celestial
e 32 bodies that orbit the sun. Each planet in
s = _:‘ [ ] the solar system has unique |
District 3| Percent P o 01 characteristics 05 s
2 5 Count 6 1
= 2
z 777 | e
DEMO School @ — = = 0.13 ] 0.5 0.3
8 caunt "o 1
&
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View an ltem
You can view the actual items themselves, along with student responses to those items. This is only
available on non-secure tests (Benchmark and Checkpoint) and teacher-authored tests.

Do either of the following:

e Toview the item in a blank state, click the item number in the first row of the report table.

e To view the student’s response to the item, find that student’s name in the Student column on the
left. Then click the score the student obtained on that item.

The Item View window appears (Figure 33). It contains an Item & Score tab and a Rubric & Resources
tab. A banner at the top of the window displays the item’s number, score (when the item includes the
student’s response), and confidence level (when a machine-suggested score has a low confidence level).
The Item & Score tab (Figure 33) shows the item and may include a particular student’s response.

Figure 33. Item View Window: ltem & Score Tab with Student Response

Grade 8 Mathematics Benchmark Test
[ € temas | Student: 1RegressionLN, Demo15.1RegressionFN  —— | temas » ||
Current Item: 41 Score: 1/1 Item & Score Rubric & Resources
Scoring Assertion Outcome

1. The student selects 5 and 5.04, providing evidence of the ability to use rational approximations of irrational numbers

to solve problems. v

Iltem Language: English

student setting(s)

The value cf\]’; lies between 2.2 and 2.3.

Select all possible values of k.

1.49

48

2 504

The Item & Score tab may include the following sections.

e Scoring Criteria: When you’re viewing a student’s response and the item has scoring criteria, the
Scoring Criteria table (Figure 34) lists the name, maximum points, points earned, and condition
codes for each scoring criterion. This table also allows you to modify scores for items with editable
scores.
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Figure 34. Item View Window: Item & Score Tab with Student Response and Scoring Criteria Table

Grade 4 English Language Arts Benchmark Tests
| € ttem2s | Student: OSTDemos, FN >
Current Item: 8 Score: 0/10 Condition Code: Non-Scorable Language (Uninterpretable Language) Item & Score Rubric & Resources
Scoring Criteria Max Points Points Earned Condition Code
CONVENTIONS 2 1 None
ELABORATION 4 2 /‘ None
ORGANIZATION 4 2 None

Scoring Note

User Date Note

-+ Add Note

student setting(s)

Passage 1: Should n
everyone get a prize<
by Brenda Iasevoli

Should young athletes get an award just for participating in a sport?

e Scoring Assertion: Each scoring assertion contains both a statement that provides information
about what the student did in their response and the content knowledge, skill, or ability that is
evidenced by their response. When you’re viewing a student’s response and the item has scoring
assertions, the Scoring Assertion table appears, listing each assertion and outcome (Figure 33).

e Item: Displays the item as it appeared on the assessment in the Student Testing Site. For items
associated with a passage, the passage also appears.
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The Rubric & Resources tab (Figure 35) may include the following sections, which you can expand and
collapse by clicking @ and @, respectively.

Figure 35. Item View Window: Rubric & Resources Tab

Grade 4 English Language Arts Benchmark Tests
[ € tem2s | Item 8 - Currently Showing
Current Item: 8 Item & Score Rubric & Resources
~ Details
Topic Writing Content Alignment = Domain: W: Writing Standards

Strand: WIAE: Argumentative Essay
Standard: W|AE|W.4.1: Write opinion pieces on topics or texts, supporting a point of view with reasons and
information.

. Rubric

4 points

Purpose, Focus, Organization

The response is fully sustained and consistently focused within the purpose, audience, and task; and it has a clearly stated opinion and effective organizational structure creating
coherence and completeness. The response includes most of the following:

A strongly maintained opinion with little or no loosely related material
Skillful use of a variety of transitional strategies to clarify the relationships between and among ideas

Logical progression of ideas from beginning to end with a satisfying introduction and conclusion

e Details: May provide the following information:

e Topic: Skill area to which the item belongs.
e Content Alignment: Describes the standard to which the item is aligned.

e Rubric: Displays the criteria used to score the item. This section may also include a score
breakdown, a human-readable rubric, or an exemplar, which provides an example of a response for
each point value.

e Frequency Distribution of Student Responses: The table in this section provides a breakdown of
how many students in the school earned each possible point value available for a fixed-form
test item.

View Items with and Without the Students’ Visual Settings

When viewing items with students’ responses, you may or may not want to see the items exactly the
way the students saw them on the test. For example, some students’ tests are set to use large fonts,
different color contrast, or Spanish.

1. From the Features & Tools menu, select Set Student Setting on Item View. The Set Student Setting
on Item View window appears.

2. Select Yes to show students’ visual settings on all items or No to hide them.

3. Click Save.
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You can also show or hide visual settings on a per-item basis. To do so, click the toggle at the upper right
of the item you’re viewing (Figure 70). This action has no effect on your global setting.

What It Means When a Student Response Contains Highlighted Text

When a student’s text response contains too much text copied from the item prompt and a condition
code of Insufficient Original Text to Score has been applied, the copied portion is automatically
highlighted.

Navigate to Other Iltems from the Item View Window

Use the buttons 4l P labeled with the previous and next item numbers at the upper corners of the
Item View window.

View Another Student’s Response to the Current Item

If you have accessed the student’s response from a report showing multiple students, you can click the

arrows beside the Student field m at the top of the window. The students are listed in the
same order in which they are sorted in the report.

What It Means When an Item Score Reads “n/a”

You may sometimes see “n/a” instead of a score for an item. In some cases, the student did not respond
to the item or the item was not included in that form of the test.

Individual Student Reports (ISR)

This section discusses Individual Student Reports (ISR), each of which provides easy-to-read
performance data on a student’s test. If a student took tests multiple times, an ISR will be available for
each test opportunity (an instance of a test the student took). ISRs are useful for sharing performance
information with students and their parents and guardians and may be generated in the language of
your choice.

What an Individual Student Report (ISR) Looks Like and How to Read It

An ISR is a PDF that displays test results for an instance of test that a student took. It may consist of a
single page or multiple pages. ISR layouts vary according to the type of test. Details of sample ISRs are
shown below in Figure 36, Figure 37, Figure 38, Figure 39 and Figure 40.

e At the top of each ISR are the student name and SSID, the name of the test, district and school, and
any other relevant information.

e Below that is a summary of the student’s performance. An ISR for a scale-scored test displays the
student’s performance on a vertical scale that includes all the cut scores and performance levels.

e Some ISRs include a comparison table showing the average performance of the state, district,
and/or school.

e Many ISRs include a table detailing the student’s performance in each reporting category (as in
Figure 37).
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e ISRs for English language arts tests can include details on the student’s writing performance broken
down by dimension (Figure 38).

e Some ISRs include item-level data (Figure 39).

e Some ISRs include longitudinal graphs (Figure 40).
Figure 36. Detail of Individual Student Report (ISR): Science Benchmark Test

Ohio | oz ’ Reporting Individual Student Report
LN, FN Grade 8 Science Benchmark Test 2023-2024
Student ID: DEMO02477 | Student DOB: 3/1/2008 | Enrolied Grade: 5 DEMO District
Date Taken: 7/12/2023 DEMO School
Scale Score: 644  Performance: Limited
How Did Your Child Do on the Test? How Does Your Child's Score Compare?

868
Advanced A student with a score of Advanced compares absolute and Name Avougo Scale Score
relative age of geclogic features, evaluates population data linked to DEMO District 61
environmental changes and expiains the relationship between position and
potential energy. DEMO School 61
66
Aswmnmequﬂdvmwm
about refative ages of rock layers, determine frequency of phenotypes
(physical characteristics) in a species and describe forms of potential (stored)
energy.
725
Proficient A student with a score of Proficient provides evidence for how
geologic features are formed, can tell how genetic variation changes species
and explains changes in motion in examples with unbalanced forces (pushing
acan)
700
Basic A student with a score of Basic describes major geclogic processes.
(physical changes) on Earth, describes mitosis and meiosis, expiains how
different types of reproduction impact a species, and understands force
diagrams.
| 323
Score Limited A student with a score of Limited provides minimal descripton of
— tecionic plates and their a single trait
644 Punnett Square and describes potental energy (ike a car on 10p of a hill).
How Did Your Child Perform on Different Areas of the Test?
A\ Below Near @ Above
Category Performance Performance Description
Your child may be able to describe how geclogic processes formed Earth's interior and surface, but does not
Earth Science A understand that the geologic record shows proof of these processes. He or she may be able to identify the fossils
but may have trouble with relative (compared) ages.
Your child may define mitosis (exact cell copy) and meiosis (cell copy with half the original DNA). He or she can
Life Science A complete a Punnett Square. He or she can explain the positives and negatives of sexual and asexual reproduction
but may have trouble identfying each one.
Your child may know the different types of potential energy (chemical, gravitational, elastic). He or she may provide
Physical Science A imiiad descripton of how o where an cbject moves from a speciic reference pant. He or she may have lmited
understanding force and free-body diagrams.

Figure 37. Detail of Individual Student Report (ISR): Science Benchmark with Reporting Categories

Category Performance

Earth Science A

Life Science A

Physical Science A

A\ Below Proficient Mear Proficient &) Above Proficient

Performance Description

Your child may be able io describe how gedogic processes formed Earth's interior and surface, but does not
understand that the peologic recomnd shows proof of these processes. He or she may be able 1o identify the fossils
but mary have irouble with relative {compared) ages.

¥our child may define mitosis (exact cell copy) and meiosis (oell copy with half the original DRA). He or she can
comglele a Punnelt Square. He or she can explain fe positives and negafives of s=oual and asexual reproduction
bust mary hawe tnouble identifying sach one.

¥iour child mary know the different types of polential enegy [chemical, gravitalional, elastic). He or she may provide
imited description of how ar where an object moves from a specific reference paint. He or she may have limiled
understanding force and free-body diagrames.
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Figure 38. Detail of Individual Student Report (ISR): ELA Benchmark with Writing Dimensions

How Did Your Child Perform on the Essay?

Essay Raw Score Conventions

Argumentative 7 out of 10 points. The response demonstrates a partial
command of basic conventions. The
response may include the following:
various errors in usage; simple
sentence structures that do not vary,
and; an incensistent use of correct
punctuation, capitalization, sentence
formation, and spelling that minimally
impacts meaning. (1 out of 2)

Informative Not available The response was unable to be scored
for the following reason: Too few

words.

Elaboration

The response is adequate and includes thatis
related {o the purpose of the task. It includes the use of evidence,
facts, and details that are from all sources, as appropriate. It is
generally connected to the thesis statement. Elaboration of
evidencs is original writing but may be generalized. The response
includes most of the following: evidence from the sources that may
not be specific but is generally integrated into the response and
includes some reference to the source; an adequate relationship
between points and evidence; adequate elaboration on the
evidence included, and; academic and domain-specific vocabulary
that is generally appropriate for the audience and purpose. (3 out
of 4)

The response was unable to be scored for the following reason
Too few words.

Purpose

The response is adequale and reflects original writing that
reasonably addresses the lopic. It has a thesis statement and is
generally focused on the audience and purpose of the task and
includes a satisfactory alternate or opposing claim. The
organizational structure adequately reflects a sense of
completeness. The response includes most of the following: a.
thesis statement that is evident throughout. some loosely related
material; an adequate organizational structure that includes an

i and ion, and; a ion of ideas that
includes basic transitional strategies to move from one idea to
another. (3 out of 4)

The response was unable to be scored for the following reason:
Too few words

Figure 39. Detail of Individual Student Report (ISR): ELA Benchmark with Item and Standard Level Data

9 for ponal Text
Item # Standard Points
1 Determine or clanfy the meaning of unknown and multiple-meaning words and phrases based on grade 5 reading and content, choosing flexibly from a range of 0
strategies.
2 Quste from 3 text whan what the tesd says splicitly and when drawing inferencas from the test 02
3 Detarmine the maaning of general academic and doman-specific words and phrases in a texd relevant to 3 grade 5 topic or subssct ares. 1"
4 Analyze multiple accounts of the same svent or topic. noing important smilsrities and dfferences in the perspectives they represent. 01
5 Compare and contrast the overall structure (e.g.. chronology. comparison, causeleffect. problemdsoluion) of events. ideas, concepts. or information in two or more 1"
texts.

8 Integrate information from several texts on the same topic in order to write or speak about the subject knowledgesbly. 01
13 Esgplain the refationships or imteractions between two or more individuals, events, ideas, or concepts in a histoncal, scientific. or technical text based on specific 0
information in the text.

14 Determine the mesning of general academic and domain-specific words and phrases in a text relevant to a grade 5 topic o sublect area. o1
15 Quote from 3 text when ining what the text says explicily and when drawing inferences from the texdt. o
149 Detarmine the meaning of general academic and domain-specific words and phrases in a text refevant to a grade 5 topic or subject area. ]
17 Quete accurately from a fext when explaining what the text says explicily and when drawing infierences from the text. 12
12 Determing or clarfy the meaning of unknown and multiple-meaning words and phrases based on grade 5 reading and content, choosing flexibly from a range of 1"
strategies.

w Integrate information from several texis on the same fopic in order to write or speak about the subject knowledgesbly. o1

20 Comparg and contrast the overall structure (2.9., chronology, comparison, cause/efect, problemsoluion) of events, ideas, concepts. or information in two or morg 1
texds.

] for Li
Item # Standard Points
2 Explain how a senes of chapters, scenss, or stanzas fits together fo provide the overall structure of 3 particulsr story, drama, or poerm. o1
[ Quote from 3 text when expisining what the text s3ys explicitly and when drawing inferences from the text o1
10 Explain how a senes of chapters. scenes, or stanzas fits topether to provide the owerall structure of a parficular story, drama, or poem. o2
mn Compare and contrast two or mone characters, settings, or events in 3 story or drama, drawing on specific detsils in the text (2.0.. how charscters interact). o
2 Anabyze literary text development. 3. Determing a theme of a story, drama, or poem from details in the texd. indluding how characters in a story or drama respond to 02

challenges or how the speaker in a poem reflects upon 3 fopic. b. Summarze the text. incorporating a theme determined from details in the text
i Quote accurately from 3 fext when explaining what the text says explicifly and when drawing inferences from the text o1
» Analyze lterary text dewelopment. 3. Determing a theme of @ story, drama, or poem from details in the text. including how characters in a story or drama respond to

challenges or how the speaker in 2 poem refiects Upan 2 fopic. b. Summarize fhe fext, incorparaiing @ theme detemmined from defals in fhe fext w
23 Describe how a namator’s or speaker's point of view and perspective influence how events are described. 172
24 Explain how a senes of chapters, scenes, or stanzas fits topether 1o provide the overall structure of a particular story, drama, or poam. 1"
25 Describe how a narrator’s or speaker's point of view and perspective influence how events are described. (]
2 Duurmeurdaﬁlhemﬁngﬂmmmw-ﬂmw-ds:dmah;:ahudungrmbrmimwmmmmﬂﬂmb&m.wd "
27 Comgare and contrast stories in the same genre (e.g., mysteries and adventure stories) on their approaches to similar themes and topics. o
] Compare and contrast two or maone characters, settings, or events in a story or drama, drawing on specific details in the text (2.0 how characters interact). 01
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Figure 40. Detail of Individual Student Report (ISR): Science Benchmark with Longitudinal Graph
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Generate and Export Individual Student Reports (ISR)

To generate and export an Individual Student Report (ISR) that details a student’s performance on a test
opportunity, use the Student Results Generator. You can select any combination of a test reason,
assessments within a subject, and students in order to generate either a single ISR or multiple ISRs

at once.

You may want to use the Student Results Generator to simultaneously print large numbers of ISRs.
ISRs can be generated from almost any Reporting page.

e C(Click the Download Student Results button in the Features & Tools menu. The Student Results
Generator window opens (Figure 41).

Figure 41. Student Results Generator Window as Opened from Performance on Tests Report

Student Results Generator

Report - =
EOELE Search by Student ID  Enterup to 5 comma
@ Individual Student Report Student Data File

Report Options
Include only those students who were mine when they

Select a test reason.

tested.
2022-2023

SUOSBaY 1531 198135 "L €

Print Options

Report Format 2023-2024

@® single PDF Multiple PDFs in a ZIP file 2023-2024 (AASCD)
PDF Type 2023-2024 (OELPS)
@® Simple Detailed

Adult Tester Fall 2023
Adult Tester Winter 2024
Fall 2023 (OST)
Post-Instruction
Pre-Instruction

Spring 2024 (Al-OELPA)

Spring 2024 (OELPA)
=3

Spring 2024 (0ST)

Depending on what page you open the Student Results Generator from, the options available to you
may be prepopulated or preselected; for example, the Student Portfolio Report prepopulates a single
student, and the Student Performance on Test report preselects a single test opportunity. However, the
filters applied to the page have no effect.

o Inthe panel on the left, select Individual Student Report. Always do this before you make other
selections. Switching between the Individual Student Report and Student Data File options may
revert some selections.

1. Optional: Select Include only those students who were mine when they tested. This setting allows
you to include students who were associated with you at the time of testing (regardless of their
current associations). If you mark this checkbox, students who were not associated with you at the
time of testing are excluded.
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This option appears only if the reporting time is set to the current date in Change Reporting Time
Period.

e |f you're generating multiple ISRs, then under Report Format, choose either a single PDF for all
the ISRs, or a ZIP file containing a separate PDF for each one. If you select Single PDF, the
Student Results Generator may nonetheless create a ZIP file of multiple PDFs depending on the
number of schools, grades, and opportunities included.

e Under PDF Type, select either a simple or detailed PDF.

o If the test opportunity options are not preselected, or if you want to change them, there are two
ways to make selections:

e Search for students. In the search field at the upper-right corner, enter up to 5 comma-
separated student IDs and click Search. The resulting list of students and all the tests they’ve
taken will replace any previous selections. To deselect and clear results, click Clear Search
Results.

e Use the three accordion sections. (If a student is prepopulated by the Student Portfolio Report,
first remove the student by clicking Clear Search Results.) Starting from the left, click the section
bars to expand them or use the Next and Previous buttons to navigate. Within each section you
must make selections using the radio buttons and checkboxes.

i. In the Select Test Reason accordion section, choose a test reason. Test reasons are
either test windows or categories for tests.

ii. In the Select Assessments section, choose any number of tests or grade levels within a
single subject.

iii. In the Select Students section, choose students from the expandable school and/or class
(roster) options. If you're a district-level user, you may choose students in up to three
schools.

Sometimes the list of students is truncated. You can display the entire list by clicking Click
to Load More.

Note that marking the checkbox for a student in one class (roster) or school also marks it
anywhere else the student appears, and the same goes for clearing the checkbox.

e Optional: If you used the accordion sections to make your selections, then to set a range of
processing dates for which to generate results, use the filter menu as follows:

a. Open the Filters menu. The menu displays two date fields.
b. Use the calendar tools to select dates or enter them in the format mm/dd/yyyy.

c. Click Apply.
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d. Optional: To revert to including results for all available dates, reopen the filter menu, click Clear
Filters, then click Apply.

Note that processing date is not always the same as the date a test was taken.
e From the Language drop-down list (if available), select a language for the ISR.

o Click Generate. Once ISR generation is finished, the Secure File Center contains the new ISR(s)
available for download.

Generate and Export Student Data Files

This section discusses student data files, which are useful for analysis.

To generate and export student data files, use the Student Results Generator. You can select any
combination of a test reason, assessments, and students in order to generate and export the files.
You can generate student data files from almost any report page.

1. Click the Download Student Results button in the Features & Tools menu. The Student Results

Generator window opens (Figure 42).

Depending on what page you open the Student Results Generator from, the options available to you
may be prepopulated or preselected; for example, the Student Portfolio Report prepopulates a
single student, and the Student Performance on Test report preselects a single test opportunity.
(The filters applied to the page have no effect, however.) You can change the selections.

2. Inthe panel on the left, select Student Data File, as in Figure 42. Always do this before you make

other selections. Switching between the Individual Student Report and Student Data File options
may revert some selections in this panel to the defaults.
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Figure 42. Student Results Generator Window
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3. Optional: Select Include only those students who were mine when they tested. This setting allows
you to include students who were associated with you at the time of testing (regardless of their
current associations). If you mark this checkbox, students who were not associated with you at the
time of testing are excluded.

This option appears only if the reporting time is set to the current date in Change Reporting Time
Period.

4. Under Report Format, select XLS (Excel .xIsx), CSV (comma-separated values), or TXT
(fixed-width text).

5. Under Output, select either Data File for Each Test or Single Combined Data File.

6. If the test opportunity options are not preselected, or if you want to change them, there are two
ways to make selections:

e Search for students. In the search field at the upper-right corner, enter up to 5 comma-
separated student IDs and click Search. The resulting list of students and all the tests they’ve
taken will replace any previous selections, as in Figure 43. To deselect and clear results, click
Clear Search Results.
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Figure 43. Student Results Generator Window: Student Search Results
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e Use the three accordion sections. (If a student is prepopulated by the Student Portfolio Report,
first remove the student by clicking Clear Search Results.) Starting from the left, click the section
bars to expand them or use the Next and Previous buttons to navigate. Within each section you

must make selections using the radio buttons and checkboxes:

i In the Select Test Reason section (Figure 44), choose a test reason. Test reasons are
either test windows or categories for tests.

Figure 44. Student Results Generator Window: Select Test Reason Section
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ii.  The Select Assessments section (Figure 45) groups tests by subject and grade. Mark the
checkboxes beside the tests or groups of tests you want to include in the report or mark
All Subjects.

Figure 45. Student Results Generator Window: Select Assessments Section

Student Results Generator

IS Search by Student ID  Enter up to 5 comma-separated student IDs
O Individual Student Report @ Student Data File
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using the default CRS layout.
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Data File layout.

~ B Grade4

Grade 4 English Language Arts

Grade 5 English Language Arts

~ B Grades

( 1 ¥ Grade 6 English Language Arts
= @ oot

. M arade7

iii. In the Select Students section (Figure 46), select any number of students from the
expandable school and/or class (roster) options.

e Sometimes a list of students is truncated. You can display the entire list by clicking
Click to Load More.

e  Marking the checkbox for a student in one class (roster) or school also marks it
anywhere else the student appears, and the same goes for clearing the checkbox.
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Figure 46. District-Level User View: Student Results Generator Window: Select Students Section

Student Results Generator
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. [] ODE AuthRoster3
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7. Optional: If you used the accordion sections to make your selections, then to set a range of
processing dates for which to generate results, use the filter menu as follows:

a. Open the Filters menu (Figure 47). The menu displays two date fields.
b. Use the calendar tools to select dates or enter them in the format mm/dd/yyyy.
c. Click Apply.

d. Optional: To revert to including results for all available dates, reopen the filter menu, click
Clear Filters, then click Apply.

Note that the processing date is not always the same as the date a test was taken.
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Figure 47. District-Level User View: Student Results Generator Window: Select Students Section with
Filters Menu Open
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8. Click Generate. Once the data file generation is finished, the Secure File Center contains the new
student data file(s) available for download.

Note that if a student took a test multiple times, the files will include each test opportunity.
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Compare Students’ Data with Data for Your State, District, School, and/or
Total Students

In the Performance on Tests report and the Student Portfolio Report, you can access performance data
for your state, district, school, and/or total students.

Compare All Your Students’ Performance on Any Test with Larger Groups’

In the Performance on Tests report (Figure 48), click ™ to the right of a test name.

Select Role > Dashboard Generator > Dashboard > Performance on Tests

Figure 48. Teacher View: Performance on Tests Report
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Rows containing data for the state, district, and/or school appear below, as in Figure 49.

Select Role > Dashboard Generator > Dashboard > Performance on Tests
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Figure 49. Teacher View: Performance on Tests Report with Expanded Comparison Rows
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click 7 to the right of the test name.

Compare a Student’s Performance on Any of Their Tests with Larger Groups’

In the Student Portfolio Report, you can compare a student’s performance on any test with that of your
state, district, school, and/or total students.

1. Enter the student’s SSID in the search field in the upper-right corner and click the search button.
(When you are viewing the Dashboard Generator and data are available, the same field appears to
the right of the dashboard generation controls.) The Student Portfolio Report appears.

Teachers can also access this report from the Performance on Tests report by going to the My
Students table at the bottom of the page and clicking a student's name.

2. Click s to the right of a test name (Figure 50).

Figure 50. Teacher View: Student Portfolio Report
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Rows containing data for your state, district, school, and/or total students appear below, as in Figure 51.

Figure 51. Student Portfolio Report with Expanded Comparison Rows
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To hide the comparison rows, click A to the right of the test name.
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Set Up Reports to Suit Your Needs

You can set up your reports so it’s easier to access the data that are most important to you. For
example, if you're a teacher, you may want to hide certain tests in subjects you don’t teach or you may
want to narrow down your reports to a single roster.

This section explains how to make several different adjustments to reports: showing only the tests
you’re interested in; showing only the classes (rosters) you’re interested in; showing only the schools
you’re interested in; assigning and filtering by test reasons; filtering item-level data by standards and
clusters of standards; and viewing data from a previous point in time.

Filter Tests to Display

You can temporarily filter which tests you want to see in your reports. You may want to do this, for
example, if you are an ELA teacher and you don’t want to see your students’ math scores. By default,
the data for those math assessments appear in your reports.

1. On the left side of the dashboard or the Performance on Tests report, click the Test Groups button.
The Filters panel expands (Figure 52).

2. Mark as many selections as you like in the Test Groups section of the filters panel (Figure 52). Tests
are organized by test type, subject, and grade.

Figure 52. District-Level User View: Dashboard with Expanded Filters Panel
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3. Click Apply. The report updates to show only data for those tests.
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4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.
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Teachers and School-Level Users: Filter Classes (Rosters) to Display

Rosters usually represent classes, but can represent any group that’s meaningful to users, such as
students who have taken honors courses. Each roster is associated with a teacher. To learn how to
create and modify rosters in the Reporting System, see Class (Roster) Management.

In the Performance on Tests report, teachers and school-level users can filter by a particular roster.
When you filter, you eliminate students not in the selected class from the data you’re viewing.

Filtering by roster makes it easy to focus on a particular class’s performance. And by switching filters,
you can easily compare one class with another. If you don't filter by roster, the reports default to
showing data for all classes. You may find data for a single class easier to understand.

1. On the left side of the Performance on Tests report, click the Rosters button. The Filters panel
expands (Figure 53).

2. Make a selection from the drop-down list in the Rosters section (Figure 53).

a. Ifyou’re a school-level user, you must first select a teacher from the drop-down list, and
then select a particular class (roster) from the second drop-down list that appears. By
default the first class listed is selected.

Figure 53. Teacher View: Performance on Tests Report with Expanded Filters Panel

Select Role > D Generator > Dashboard > Performance on Tests Enter Student ID Q

- —F
Filters = A My Assessments 31! Features & Tools

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
Fittered By Rosters: All Roster | TestReasons:All Test Reasons | Reporting Time Period: 05/01/2023 |

2 w Test Groups

— Test Test Test Student Average pro Date Last
,i='E‘ ~ TestReasons ST Group Grade Reason Count Score Eerfomnancelitiaston Taken ¥
AllTest Reasons v Grade 7 Engiish L snguage ENEER o
& Arts Benchmark Tests v | Benchmark 7 OH_RRA_2.- 18 740 @  percent 22% 6% 1% 5% 01/24/2023
Coumt 4 1 3 1o
o — A ©
e & mgﬂﬁizjw v | Benchmark 4 OH_RRA_2... 18 816 @ | percem == 01/24/2023
[‘All Rosters - count ®
Grade 5 English Language Pre- L]
& | Arts Benchmork Tesis V| Benchmark 5 Instruction ! w7 @ Frent oo 0172872023
o
Grade 3 English Language -:l [ ]
& | Ats penchmark Tests Y| Benchmark g ||| W 69 @ e wn 01/19/2023
Rows per page: 10 4 |ltems: 1 of 1
. My Students
Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons | Reporting Time Period: 05/01/2023 |
Student Name Student ID Most Recent Assessment Date Taken +«
Clear Filters LN-RDLdata, FN DEMO08540 Grade 7 English Language Arts Benchmark Tests 01/24/2023
LN-RDLdata, FN DEM008532 Grade 7 English Language Arts Benchmark Tests 01/24/2023
Apply
- LN-RDLdata, FN DEMO08538 Grade 7 English Language Arts Benchmark Tests 01/24/2023

3. Click Apply. The report updates to show only data for that class (roster).

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.
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The row of filter details below each table header shows the classes (rosters) you’re viewing
(Figure 53).

District-Level Users: Filter Schools to Display

Filtering the Performance on Tests report by school makes it easy to focus on a particular school’s
performance. And by switching filters, you can easily compare it with another school. If you don’t filter
by school, the Performance on Tests report defaults to showing data for all schools. You may find data
for a single school easier to understand.

1. On the left side of the Performance on Tests report, click the Schools button. The Filters panel
expands (Figure 54).

2. Make a selection from the drop-down list in the Schools section (Figure 54).

Figure 54. District-Level User View: Performance on Tests Report with Expanded Filters Panel

Dashboard Generator > Dashboard > Perf 1ce on Tests Enter Student ID O\
¢ ok P as
Filters i= Average Score and Performance Distribution, by Assessment: DEMO District, 2023-2024 131 Features & Tools
Filtered By School: All Schools | Test Reasons:All Test Reasons |
'iE:: v Test Groups Date
- Assessment Name jLest jlest jest Stucent ATSEa08 Performance Distribution Last «
Group Grade Reason Count Score
Taken
@ ~ TestReasons P
Geometry Benchmark Post- _
R Test v | Benchmark 10 Instruction 1 714 @ | percem 00% 07/24/2023
Count 1
&  Schools
Algebra Benchmark Post- L]
All schools v & | Test Vv Benchmark 10 thon 1 74 @ |recem 100w 07/24/2023
- Count 1
iteuteg 72777k
&, | Mathematics II “  Benchmark 10 2023-2024 2 652 @ | percem 100% 07/24/2023
Benchmark Test Coum 2
Integrated _ L
Clear Filters &, Mathematics | ~ | Benchmark 10 2023-2024 3 642 @ | percem 100% 07/24/2023
Benchmark Test Coum 3

Apply Rows per page: 4 18 ltems: 1 of5 »

3. Click Apply. The report updates to show only data for that school.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

If you click the name of a test when you’ve filtered by a single school, the link will take you to the School
Performance on Test report and not to the District Performance on Test report.

The row of filter details below the table header shows the schools you’re viewing.

Assign Test Reasons (Categories) to Non-Summative Test Opportunities

Test reasons are categories used to classify test opportunities for reporting purposes. They typically
indicate the timeframe in which tests were taken, and they’re a good way to organize tests into groups.

Test reasons should ideally be assigned in the Test Administration Site at the time of testing. However,
you can use the Test Reason Manager in the Reporting System to assign a different test reason to a
Benchmark, Checkpoint or teacher-authored test opportunity that was completed in the current school
year. Summative test reasons cannot be reassigned.
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1. From the Features & Tools menu, select Manage Test Reasons. The Test Reason Manager window
opens (Figure 55).
Figure 55. Test Reason Manager Window

Test Reason Manager

= Search Test Sessions for Test Reason

You can only modify the test reason for test opportunities completed during the current school year.

Session ID: Please Type a Session ID
—or—

Test Reason Filter:  Select a Test Reason v

Session Start Date: s End Date: s

Please select a date range no more than 7 days.

2. To search for the test opportunities you wish to categorize, do either of the following:

e Inthe Session ID field, enter the session ID in which the opportunities were completed in Test
Delivery System.

e Select the test reason associated with the opportunities you want to edit. Then select a range of
dates during which the test session was administered. The date range cannot exceed
seven days.

3. Click Search.
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4. Alist of retrieved test sessions appears in the section Select Test Opportunities (Figure 56). You can
click the 4 buttons to expand the list of tests in each session and the list of students who took

each test (that is, individual test opportunities). To navigate through a long list, use the controls in
the upper-right and lower-right corners.

Figure 56. Test Reason Manager Window: Select Test Opportunities

Test Reason Manager

= Search Test Sessions for Test Reason

‘You can only modify the test reason for test opportunities completed during the current school year.

Session ID: Please Type a Session ID
—or—
Test Reason Filter:  Any A
Session Stari Dale:  07/24/2023 = End Date:  07/27/2023 iz

Please select a date range no more than 7 days.

Select Test Opportunities

# of Students in .
Session M

Session
ID

% TestDate / Time )

07/25/2023 03:21 PM - 07/25/2023  PatchRegression,
03:21 PM PatchOffing

4+ [J uAT-FCO141 1

07/24/2023 12:15 PM - 07/24/2023
UAT-CA10-1 . ODE-TAS. ODE-TAS 1
1215 PM
+ Biology Benchmark Test science grade 9 1

07/25/2023 0919 AM - 07/25/2023

4+ [J uAT-C98F- BP0 demo, demo 6
Rows perpage: |3 O 14 ftems: 1 ots)p

5. Mark the checkboxes for each session, test, or opportunity that you wish to assign to a test reason.

6. Click Assign Test Reasons below the list of retrieved sessions.

7. Inthe window that appears (Figure 57), select a new test reason to assign to the selected
opportunities and click Confirm.

Figure 57. Confirm Test Reason and Assign Opportunities Window

Test Reason Manager

Select Test Opportunities
—  SessionID & TestDate/Time & TAName & #of Students in Session s
4 [ UAT-F8D8-1 07/18/2023 11:43 AM - 07/18/2023 11:43 AM PatchRegression, PatchOffline 1
= d Confirm Test Reason and Assign Opportunities m
Please Select a Test Reason: 2022-2023 v
Session ID ¢ Student Name & StudentID ¢ Test Taken ¢ Current Test Reason Assigned ¢

UAT-E713-1 OST-ClientUAT, FN DEMOO07385 American History Benchmark TestPre-Instruction

Rows perpage: |5 O 1 Items: 1 oft

+ 0 Confirm | | Cancel
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Filter by Test Reason (Category)

Test reasons (Figure 58) are categories used to classify test opportunities for reporting purposes. They
typically indicate the timeframe in which non-summative tests were taken, and they can be a good way
to focus on specific groups of tests. For summative assessments, test reasons are simply test windows
and are not useful.

Figure 58. Teacher View: Performance on Tests Report

Select Role > Dashboard Generator > Dashboard > Performance on Tests Enter Student ID Q

—

Filters
Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
t=_= Filtered By Rosters: All Roster | Test Reasons:All Test Reasons |

Test
Groups Student Average L Date Last
Assessment Name Test Group Test Grade Test Reason Count e Performance Distribution Taken ¥
Eé Ohio's State Summer 2023 ]
== 4, | Algebral v Tests 10 (os7) 3 658 @ percent 100% 05/09/2023
Reasons Count 3
Ohio's State Summer 2023| L
&, Integrated Mathematics I v b 10 2 633 @ | pecent 00 05/08/2023
(osT)
Resters Count 2
¥, | Integrated Mathematics | \ | Ohios State 10 Summer 2023 2 658 @ e 05/08/2023
& | leorated Mathematies 1 Tests (0ST) Feroent 100
Rows per page: 3 6 ltems: 1 of2 %
A My Students
Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |
Student Name Student ID Most Recent Assessment Date Taken «
Tech-LN, Tech-FN DEMO049905 Algebra | 05/09/2023
PCB7532, PCB7532 DEM039240 Algebra | 05/09/2023
Rows per page: | 2 11 Items: 1 ofe »

When your test opportunities have test reasons, you can filter reports by a single test reason. For
example, you may want to filter by Pre-Instruction and look at ELA performance, then filter by Post-
Instruction and find out if students have improved on ELA material. If you don’t filter, you'll see data for
all different test reasons. This will allow you to compare multiple test reasons side by side rather than a
single test reason. You may find reports easier to understand when you’re viewing only a single test
reason.

The Test Reason filter is available on the dashboards and Performance on Tests reports for teachers as
well as for school- and district-level users.

1. On the left side of the dashboard or Performance on Tests report, click the Test Reasons button. The
Filters panel expands (Figure 59).
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2. Make a selection from the drop-down list in the Test Reasons section (Figure 59).

Figure 59. Teacher View: Performance on Tests Report

Select Role > Dashboard Generator > Dashboard > Performance on Tests Enter Student ID Q

. —F
Filters = A My Assessments i22 Features & Tools
= Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023
[z53, v Testerovs Filtered By Rosters: All Roster | Test Reasons: All Test Reasons | Reporting Time Period: 05/01/2023 |
— Student Average i Date Last
Eé A TestReasons Assessment Name Test Group Test Grade Test Reason Count Score Performance Distribution Taken -
All Test Reasons v Grade 7 English Language Arts Post- -:.- ]
& | Benchmark Tests v Benchmark 7 Instruction 18 740 @ P 2% o 01/24/2023
ount
rade nglish Language S ost-
& | Bencmark Tests v 4 Instruction 18 816 @ Pereent e o2
ount
Grade 5 English Language Arts V77777772 ©
& | Benchmark Tests v 5 Pre-Instruction 1 607 @ P o 01/23/2023
ount
. Grade 3 English Language Arts _:l o
= | Benchmark Tests

Benchmark 3 - 18 669 01/19/2023
Clear Filters v enchmar 20222023 QO e oz 5% nor:

uuuuu

3. Click Apply. The report updates to show only data for that test reason.

4. Optional: To revert all filters to their defaults, open the Filters panel again and click Clear Filters.
Click Apply. Filters will also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.

The row of filter details below the table header shows the test reason selected, if any.

Filter ltem-Level Data by Standards and Clusters of Standards

An educational standard describes the skill the item measures. An example of a math standard is “Write
a function that describes a relationship between two quantities.”

You may want to see how your students performed on a particular standard or cluster of standards. In
certain reports, you can filter by the standard to which items are aligned. That way you can view your
students’ performance in just one area of skill. Then you can switch filters to compare it with their
performance in another skill. If you don’t filter by standard, the reports will show results for all
standards by default. You may find that switching between different sets of standard data and
comparing them helps you understand students’ abilities better.

Standard filters are available in any report showing item-level data. The available standards vary by
assessment.

1. On the left side of the page, click the Standards button. The Filters panel expands
(Figure 60).

2. Use the drop-down list in the Standards section (Figure 60) to select a reporting category. An
additional drop-down list appears.

3. Optional: Keep making selections from the drop-down lists as they appear.

54

SPOON INOA 1IN Of spoday dn 1es



Reporting System User Guide

Figure 60. School Performance on Test Report: Performance by Roster Tab with Expanded Filters Panel

Select Role > Dashboard Generator > Dashboard > Performance on Tests > School Performance on Test Enter Student ID Q

= Performance by Roster || Performance by Student rp (s LS

I'i“ = Staas Average Score, Performance Distribution and Average Points Earned on Grade 4 Mathematics : Fractions Checkpoint 1 (2022-2023),
by Roster and Reporting Category: DEMO School 2022-2023

Reporting Category
Filtered By Rosters: All Roster | TestReasons: 2022-2023 | Standards Keys [l
FRA: Fractions v
e+ e - 0 0 o o I
Cluster = w w =
S|l=|=|g
FRAJ4.MD.B: Represent ar v & B35 g "“;’
o @ | &7
Standard S 8|3 1 2
s £
All standard(s) ~ g5 & FRAI4.NFB[4.NF.3]4NF: @ FRAJ4.NF.C|4.NF7 (i ]
N 2
= A 1pt 1pt
@ @
=
@ @
State g 37 na n/a
g g
3 ®
@ @
e a
District g F 0.5 0
F =
@
2 3
School 0.5 0
(students not in any roster). 0.5 0

Clear Filters

m Rows per page: 10 1 ltems: 1 of 1

4. Click Apply. The affected report updates to show only the items that belong to the selected
cluster or standard.
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5. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters will also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.

The row of filter details below the table header specifies the standards selected, if any.

View Data from a Previous Point in Time

Changing the reporting time period allows you to view test results from a previous point in time. There
are two time period settings.

e When you set a school year for which to view tests, the reports show data for test opportunities
completed in the selected school year.

e When you set a date for which to view students, the reports show data only for the students who
were associated with you on the selected date and only for tests taken as of that same date.
Students’ enrollment and demographic information is all given as of the selected date as well. You
can use this setting to view data for students who have left or recently entered your classes
(rosters), school, or district.

If you don’t change the reporting time period or if you reset it to the default, all reports show test
opportunities only for the current school year with current student data (except Longitudinal Reports
and Student Portfolio Reports, which always retain the ability to look back to previous years).

Some examples of how you can use this feature:

55



Reporting System User Guide

e You may want to view the past performance of your current students, including new transfer
students. In that case, set a school year in the past and keep the date set to today.

e You may want to view the past performance of your former students in order to compare them with
that of your current students. In that case, set the date to a time when your former students
belonged to you and had tested and set the school year to the same time. Then switch back to the
present to compare.

1. From the Features & Tools menu, select Change Reporting Time Period. If you're viewing the
Dashboard Generator page, click Change Reporting Time Period. The dashboard also offers this link
when no assessments are available to display. The Change Reporting Time Period window appears

(Figure 61).

Figure 61. Change Reporting Time Period Window

Change Reporting Time Period

View results for school year:  2023-2024 ~

View results for students who were mine on: ~ 07/27/2023 m

Note: All dates are in Eastern Time Reset To Today

2. From the school year drop-down list, select a school year. This is the year for which you will view
test results.
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3. Inthe View results for students who were mine on field, use the calendar tool to select a date or
enter it in the format mm/dd/yyyy. You will be viewing all the students who were associated with
you and had tested on that date, and only those students.

e To view your current students’ past performance, keep the date set to today.

e To view the past performance of your former students, set the date to a day when those
students were associated with you and had completed testing.

4. Click Save. All reports are now filtered to show only data for the selected school year and date. The
selected date displays in the filter details below the report headings. All other filters are cleared.

Optional: To go back to viewing the latest data, open the Change Reporting Time Period window
again, click Reset To Today in the lower-right corner, then click Save. The date resets and all filters
are cleared. The reporting time period also resets when you log out but persists when you

switch roles.
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Export and Print Data

You can export or print any data you see in the Reporting System. Some can be exported directly from
the Performance on Tests report. You may want to export or print to save a snapshot of data to consult
later or to share data. Different options will be available depending on the report you are viewing.

Export or Print a Report You're Viewing

1.

Zoom Level (Display only)
Normal v

Report Options
(® Summary Only

() Summary and item Scores
Print Options

® Print

*Printed image may vary from
preview. Please check your
browser's print settings and
ensure background image
printing is enabled.

() Save to PDF
() Save to Excel

() SavetoCSV

*The data in this report will be
exported to a comma separated
value document

-

Select the print button from the Features & Tools menu or, in some reports, from the upper-right
corner. If there are multiple report tables on the page, multiple print buttons appear.

A print preview page opens (Figure 62).

To zoom in on the print preview, use the drop-down list under the Zoom Level
(Display only) section. This setting affects the preview only.

Figure 62. Print Preview Page

= Department .
Ohlo of Education ‘ REDOI'tII'Ig

Average Score, Performance Distribution and Average Points Earned on Grade 4
Mathematics : Fractions Checkpoint 1 (2022-2023), by Roster and Reporting
Category: DEMO School 2022-2023

Filtered By Rosters: All Roster | Test Reasons: 2022-2022 |

o =
Merage
Raw
Soone
State na na
District z "
Schoal z W

(ehudents notIn any roster) 1

Copyright © 2022 Cambium Assessment, Inc. Al rights reserved.
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2. If an aggregate report provides data for individual items, the Report Options section appears. Select
either Summary Only or Summary and Item Scores. If you select the latter option, as in Figure 63,
the printed report includes data for the individual assessment items. Printouts of the Student
Performance on Test report always include item data if available.

Figure 63. Print Preview Page with Summary and Item Scores Option Selected

D10 lulld pub odx3

Zoom Level (Display only)
= Department P
Ohlo of Education Reportlng
Normal v
Average Score, Performance Distribution and Average Points Earned on Grade 4
Report Opt'lons Mathematics : Fractions Checkpoint 1 (2022-2023), by Roster and Reporting
Category: DEMO Schoal 2022-2023
() Summary Only Filtered By Rosters: All Roster | Test Reasons: 2022-2022 |
e — R - e
- . 1 - < - 1
Print Options | 2 i R =
Test = e FRA| | FRA| | FRA| | FRA| |,
3 m\m;::;—npom Swoent Coudt | Gompletion = j\\':fl A\:(‘:| 4\=}|«| A\:(II\ i\:AI\ ::;3'
@ Print Rzl Soore | o | ANET | ANFZ | ANFS | ANRD | oo
*Printed image may vary from - R L R IR BT
preview. Please check your -~ . . . . . . . .
browser's print settings and o o o o o o o o
ensure background image District 2 i 05 a 0 [ [ [
printing is enabled .
School H m s a Q a a a
O Save tﬂ PDF {shadents not In any roster) z m as a Q Q Q a
() Save to Excel
= — T
() Saveto CSV ; . . .
*The data in this report will be = - = | &= | = FrA|
exported to a comma separated TICEETD e || | e o
value document = Soone | ANEZ | ANFE | 4MDA L on
. ' || R | 55
m ‘ Cancel ‘ B na na na na na na
e District 2 il a a a a
School H m a a a a
{students not In any roster) 2 il a a Q a

3. To print the report, select the Print radio button. To download it, select Save to PDF, Save to
Excel (XLSX), or Save to CSV (comma-separated values).

e Optional: If a PDF is for a particular student and the report includes items, you can mark the
Include Items and Responses (takes extra time) checkbox. The resulting report includes the
actual items and the student’s responses.

e If you selected Save to PDF, choose an option from the Page Layout drop-down list that
appears.

4. Click Confirm.

If you saved the report as PDF, Excel, or CSV, the Secure File Center window appears, displaying the
generated report.
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Export an
Report

1. Click ¥,

Assessment Report Directly from the Performance on Tests

to the left of the name of the assessment whose report you wish to export (Figure 64).

Figure 64. District View: Performance on Tests Report

Dashboard Generator > D: > on Tests Enter Student ID Q

—r

= Average Score and Performance Distribution, by Assessment: DEMO District, 2022-2023 #:! Features & Tools

Filters Fiitered By School: All Schools | Test Reasons: All Test Reasons |
= Student Average L Date Last
n Assessment Name Test Group Test Grade Test Reason & e Performance Distribution Taken -
Test
G
&, || Kindergarten OFLPA v OELPA KG ot pa) 13 4675 Persent | 4% prey 02/15/2023
'= Count 7 6
&
- | o
[z o, | Grade 4 OELPA v OELPA 4 S"(grégs:)ﬁ 10 4343 ey = = 02/15/2023
Count a 2
& B o
Schoots &, | crade s oELPA v OELPA 6 S ‘Eg’é‘isgs 6 4405 percent s = 01/26/2023
Court B 2
&, | cradeooELPa v OELPA 9 S "(g’égsg)zs 9 4447 S ey oy 12/15/2022
Court 7 2
Rows perpage: 4 © 9 ltems: 1 of3 »

The Export Report window opens (Figure 65). The options in this window vary according to your

user role.
Figure 65. District-Level User View: Export Report Window
Export Report for Biology
Choose Type of Report
1. @ Overall Performance of all my Schools
O Overall Test, Reporting Category Performance of all students
Select School v
O Overall Test, Reporting Category and ltem Performance of all students
Select School v
Select Export File Type
2. ®PDF O Excel OCSV

Export Assessment Data

2. Select which report to export for the assessment.

e District-level users:

To export the district test results, mark the Overall Performance of all my Schools radio
button.
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- To export school test results (excluding data for individual items), mark the Overall Test &
Reporting Category Performance of all my Students for [School Name] radio button, then
select a school from the drop-down list.

- To export school test results (including data for individual items), mark the Overall Test,
Reporting Category and Item Performance of all my Students for [School Name] radio
button, then select a school from the drop-down list.

e School-level users and teachers:

- To export results for all your associated students (excluding data for individual items),
mark the Overall Test, Reporting Category Performance of all students. radio button.

- To export results for all your associated students (including data for individual items),
mark the Overall Test, Reporting Category and Item Performance of all students. radio
button.

Figure 66. Teacher View: Export Report Window

Export Report for American History Benchmark Test

Choose Type of Report
1. @ Overall Test, Reporting Category Performance of all students

O Overall Test, Reporting Category and Item Performance of all students

Select Export File Type
2. @®PDF O Excel OCSV

Export Assessment Data

3. Choose from the PDF, Excel, and CSV formats.
4. Click Export Assessment Data (Figure 66). A confirmation window appears.

5. Click Yes to export or No to return to the Export Report window. When you’ve exported a file, the
Secure File Center window appears with the generated file available for download.
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Score Items

The Reporting System allows authorized users to score certain items on certain tests.

Some items that require hand scoring arrive in the Reporting System without any scores. For
example, some items available in Assessment Authoring require hand-scoring. If a test contains
unscored items, its performance data are excluded from your reports until an authorized user scores
all the unscored items of that test.

Other items arrive in the Reporting System with automated scores suggested by the machine
scoring system. Authorized users can override these scores if necessary. For example, Checkpoint
writing items have machine-suggested scores that can be overridden.

Score Unscored Items

For a student’s test performance to be reported, you need to enter scores for any hand-scored item
responses on that test.

When you have tests with unscored items, a Tests To Score notification appears in the banner.

1.

2,

In the banner, click Tests To Score.
If the Select School page appears, make a selection and click Continue.

On the scoring Dashboard (Figure 67), click the name of the test you wish to score. The Test Scoring
page appears (Figure 68), displaying a list of students and items awaiting scoring for the selected
test. This table only includes assessments completed by students in your rosters or students in your
test sessions.

Figure 67. Scoring Dashboard

Dashboard

Change School

Assessments to score for All Rosters, 2023-2024

Assessment Name Test Reason Sé:i:t “Se:::eto I::u?:“:: Date Last Taken +
PS Hand Score 2023-2024 1 1 0 07/28/2023
Grades 2-3 OELPS Unassigned 3 5 0 07/28/2023
Grade 1 QELPS Unassigned 2 2 2 07/27/2023
Grades 9-12-0ELPS Unassigned 2 15 1 07/27/2023
Beginning of Kindergarten OELPS Unassigned 2 4 0 07/27/2023
Rows per page: 5 13 lkems: 1 of3
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Figure 68. Test Scoring Page

Dashboard > Test Scoring

Change School
PS Hand Score (2023-2024) to score for DEMO School, 2023-2024

Submit Student - Student ID Date Taken Items to Score

ltem Numbers and Max Points

LN, FN DEMO02717 7/28/2023 3:18:56 PM Score

Rows perpage: 10 © 1 Items: 1 of 1

4. To enter scores for an item response, click the Score link or score number link for the item in the
required student’s row. The scoring window opens to the Item & Score tab.

5. Optional: You can open the Rubric & Resources tab (Figure 69) to review the item’s scoring rubric
and any other available resources, such as an exemplar and training guide for scoring the item.

Figure 69. Item View Window: Rubric & Resources Tab

PS Hand Score

4 Student: LN, FN >

Current Item: 1 Score: Score /2 Condition Code: None Item & Score Rubric & Resources
A Details

Content Alignment Content Strand: FM: Forces and Motion
Content Statement: PS.FM.1: Motion

# Rubric
2 points

The response includes:

« acorrect description of where the ball would most likely land;
AND

« acorrect explanation of the motion of the ball.

6. On the Item & Score tab (Figure 70), click the edit button 7 inthe Scoring Criteria table at the top
of the window.

7. Review the student’s entered response and do one of the following:
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e |[f the student’s response is scorable, select the appropriate score from the drop-down menu in
the Points Earned column.

e If the student’s response cannot be scored for any reason, select the appropriate condition code
from the drop-down in the Condition Code column. For more information about condition
codes, refer to Condition Codes.

PS Hand Score

<

Current tem: 1

Scoring Criteria

Correct Answer

Scoring Note

User

+ Add Note

Score: Score /2

Student:

LN, FN

Condition Code: None

Max Points

2 pt

Ball Drop

Date

Points Earned

Not Scored

Note

Figure 70. Item View Window: Item & Score Tab

ltem & Score

Condition Code

None

8. If the item has multiple scoring criteria, repeat step 6 for each criterion.

>

Rubric & Resources

student setting(s)

OFF

.

Lo\

e When assigning condition codes to multiple scoring criteria, note that some related criteria may
require the codes to be the same.

9. Click Save.

10. Optional: If you wish to provide an explanation for the given score(s) or condition code(s), click
Add Note in the Scoring Note section, then enter your comment and click Save. All notes will be
deleted when scores are submitted, as described in Submit Scored Test Opportunities for

Processing.

11. To continue scoring items, do one of the following:

e To view another unscored item for the same student, use the buttons labeled with the previous
and next item numbers at the upper corners of the scoring window.

e To view the same unscored item for another student, click the up or down arrows on the right

side of the Student field at the top of the window.

e To return to the Scoring Mode window and select another item manually, close the Item View

window using the close button at the upper-right corner.
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12. Repeat these steps until you have entered scores for all the unscored items for the test.

13. Optional: If you need to change the entered score for an item response, you can select the score link
for that item on the Test Scoring page and repeat these steps.

Once you have entered scores for all the unscored items in a test opportunity, you may submit that
opportunity for processing.

To return to reports, click the close button at the upper-right corner.

Change the Selected School

Scoring mode allows you to score the item responses for only one school’s test opportunities at a time.
If you are associated with multiple schools, you may change the selected school in order to score the
test opportunities from other schools.

1. To change the selected school, click Change School in the top-right corner of the Dashboard. The
Select School page appears (Figure 71).

Figure 71. Select School Page

Select School

Please select the School you wish to use.

TA (@ School: Demo inst 9999 w

Continue

2. From the Teacher drop-down menu, select the school whose student responses you wish to score.

Teacher

3. Click Continue. The Dashboard page appears, displaying the tests available for the selected school.

Submit Scored Test Opportunities for Processing

In order for a test opportunity’s scores to be reported, you will need to submit that opportunity for
processing. You may only submit an opportunity once you have entered scores or condition codes for
every hand-scored item on the test.

1. To submit scored opportunities for processing, navigate to the Test Scoring page (Figure 72) and
mark the checkbox in the Submit column for each opportunity you wish to submit.

e You can mark the checkbox at the top of the Submit column to select all fully scored
opportunities at once.
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Figure 72. Test Scoring Page: Submitting an Opportunity

Dashboard > Test Scoring

Grade 1 OELPS (Unassigned) to score for DEMO School, 2023-2024

Submit Student - Student ID Date Taken Items to Score

tem Mumbers and Max Points

1 2
3 pt 4pt
LN, FN DEMO02875 6/30/2023 4:19:07 PM 2 0
Rows per page: 10 1 ltems: 1 of1

Submit Score(s)

2. Click Submit Score(s) in the bottom-left corner of the page.

3. Inthe confirmation window that pops up, click Continue. The selected opportunities will be
submitted for processing and reporting and removed from scoring. Any scoring notes will be
deleted.

To return to reports, click the close button at the upper-right corner. You can still modify the item scores
on that test directly from the reports by following the procedure in the next section,
Modify Scores for Items in Reports.

Modify Scores for Iltems in Reports

You can modify scores for some items directly from the Item View window that opens from a report.
Reports display a pencil icon # in the column header for each item with a modifiable score (Figure 73).
When a machine-suggested score has a low confidence level, or when a condition code of Non-Specific

or Uninterpretable Language has been assigned by machine, & displays next to the score. It is highly
recommended that you review items flagged with this icon.
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Figure 73. School Performance on Test Report: Performance by Student Tab with Expanded Reporting
Category Section

Dashboard Generator > Dashboard > Performance on Tests » District Performance on Test > School Performance on Test Enter Student ID Q

Score, Performance and Points Earned on Grade 4 English Language Arts Benchmark Tests (2022-2023) of All Rosters, by Student and Reporting Category: DEMO
School, 2022-2023
Filtered By School: All Scheols | Test Reasons:2022-2023 | Standards Keys il

-
B e s oo 0 0 0 o o o I
g 2 o =z 2 =
g @ & 2 2 = Item Numbers, Max Points and Points Earned
2 32 @ 2 @
S § 5 © 8 F
= = g z Performance
g 5|8 | < WIAE|W.4.1 o
Bl = BES =
2 218|¢g
a a =z = 10pt
R
@ @ Y
State g & n/a n/a
-
=8 2
a a o
District Z 7 Percent 7% 25% 125
® = Count 3 1
a2 3
- L]
School Percent 75% 25% 125
Count 3 1
0STDemos, FN DEMO06657 Above Proficient 5
test, test DEMO09533 Below Proficient 0
test, test DEMO36135 Below Proficient 0
Scores of items marked with €. can be reviewed
Rows perpage: 3 °© 4 ltems: 1 of2 »

1. On a report with modifiable scores, click the item score link in the student’s row of the report. The
Item View window opens.

2. Optional: You can open the Rubric & Resources tab (Figure 74) to review the item’s scoring rubric
and any other available resources.

Figure 74. Item View Window: Rubric & Resources Tab

Grade 4 English Language Arts Benchmark Tests
[< remas | Item 8 - Currently Showing >
Current Iltem: 8 Item & Score Rubric & Resources
. Details
Topic Reading Content Domain: W: Writing Standards
Informational Alignment Strand: W|AE: Argumentative Essay
Text Standard: W|AE|W.4.1: Write opinion pieces on topics or texts, supporting a point of view with

reasons and information.

~ Rubric

4 points

Purpose, Focus, Organization
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3. Onthe ltem & Score tab (Figure 75), review the student’s entered response and click /' in the

Scoring Criteria table at the top of the window. The Points Earned and Condition Code columns
become editable.

Figure 75. Item View Window: Item & Score Tab

Grade 4 English Language Arts Benchmark Tests
|m| Student: 0STDemos, FN ~]
Current ltem: 8 Score: 5/10 Item & Score Rubric & Resources
Scoring Criteria Max Points = Points Earned Condition Code
CONVENTIONS 2 1 None
ELABORATION 4 2 /‘ None
ORGANIZATION 4 2 Nane

4. Do one of the following:

e To enter a score for the response, select a numerical score from the Points Earned
drop-down list.

e To assign a condition code to the response, select one from the Condition Code drop-down list.

5. If the item has multiple scoring criteria, repeat step 4 for each criterion.

6. Click Save.

7. Optional: If you wish to provide an explanation for why you chose the given score or condition code,
click Add Note in the Scoring Note section, then enter your comment and click Save. Any notes will
be deleted when the scores are processed.

8. To continue modifying scores, do one of the following:

e To view another item for the same student, use the buttons labeled with the previous and next
item numbers at the upper corners of the Item View window.

e Toview the same item for another student, use the up or down arrow buttons on the right side

! Demo Student

of the Student field : I at the top of the Item View window.

The performance data in the test results update automatically when you close the Item View window.
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Appendix

Appendix sections are alphabetized for your convenience.

C

Class (Roster) Management

Classes (rosters) are groups of students. Each roster is associated with a teacher. Each is also associated
with a single administrative year. They typically represent entire classrooms in lower grades or individual
classroom periods in upper grades. They can also represent any group that is meaningful to users. A
student may belong to more than one class.

Teachers, school-level users, and district-level users can add, edit, and delete rosters. Rosters are a great
way to organize students, allow teachers to view their students’ performance, and allow other users to
compare the performance of different classes. Changes to rosters may take a few minutes to appear in
reports.

When creating rosters, follow the guidelines below:

e Rosters should ideally include about 25—-30 students. If a roster is too large or too small, it may
affect the credibility and usefulness of the data available in reports.

e  When naming rosters, a clear and consistent naming convention should be used that indicates the
grade, class name, teacher, and/or period as applicable. For example, an elementary school roster
may be named “Gr3Jones23-24" and a secondary school roster may be named
“AikenPeriod3Eng9A23-24".

A few restrictions to be aware of when creating rosters:
e Each roster can only be associated with one school.

e You can only add students who are enrolled in the school or district associated with your user
account.

e Only 500 active students can be included in one roster.

Add a Class (Roster)

You can create new classes (rosters) from students associated with a school.

1. From the Features & Tools menu, select Add Roster. The Roster Manager window appears,
showing the Add Roster form (Figure 76).
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Figure 76. Roster Manager Window: Add Roster Form

Add Roster a8

School Detalls

Dlsirict: Dermd District 9099 - 9999
Schoot: Dema School 1 - 0995599

Find and Select Students Roster Details
Roster ihy bl ! “Teacher Nam Select i
Selected Students (0)

 infomation v Filter stsderts

V X REMOVEALL STUDENT NAME GRADE 5510

+ Additional Flelds

2. If necessary, select the district and school for the roster from the drop-down lists.
3. Add aroster name and select a teacher.
4. Decide how you want to add students:
e Quick Roster tab (search adds students automatically, manually remove students to edit)

- Use the Quick Roster tab to create a roster from a group of students. Once you select the
search criteria, all students who meet those criteria are automatically added to the roster

after you select Create Quick Roster. You can remove students manually by selecting X

next to individual students or select Remove All from the top of the grid. Selecting Save
creates your roster.

e Student Search tab (search finds students that you add and remove manually)

- Use the Student Search tab for a more traditional search function, including the option to

find specific students by ID or name. After you return results, select * to add individuals
or select Add All from the top of the grid.

> Tip: To return fewer students, limit your search by adding more criteria. Expand the
Additional Fields section to add student information criteria as available.
5. Optional: After results appear under Selected Students, change the information that displays about

students.

o Show more information drop-down: Select or clear additional columns under
Available/Selected Students grids.

(] Note: Selecting Former Students shows students who are no longer associated with the school
in italics with the date they left the school. You can still add these students to your class. Once a
student has been added to a class, the student will remain in the class even if the student is no
longer enrolled in the school.

e Use the Filter field to limit students to those who match the text you enter.
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This keyword search only finds text in the grid. Be aware if you enter 11 to find students in 11th
grade, any content with the text “11” will display. This could potentially pull in results you did

not intend to find.

e After you save, rosters may be changed from the Edit Rosters screen.

Modify a Class (Roster)

You can modify a roster by changing its name, changing its associated teacher, adding students, or
removing students.

1.

4. Inthe list of retrieved rosters, click for the roster whose details you want to view. The View/Edit

From the Features & Tools menu, select View/Edit Roster. The Roster Manager window appears,

showing the View/Edit form (Figure 77).

Select the school year, district and school as needed for the roster you wish to edit. Optionally,
select a teacher.

Click Search. Click View Results to view the results in your browser.

Figure 77. Roster Manager Window: View/Edit/Export Roster Form Showing Retrieved Rosters

Roster Manager

A

View/Edit Rosters

@ Use this page to view, edit, or delete rosters and access associated reports when available. more info v

Search for Rosters to Edit
‘i' ~

Note: For multiple roster selection, you may print 1,000 students at a time.

Number of rosters found: 5 Filter results
Edit | Roster Name Teacher Grades In Number Of
Roster Students

. Demo Roster User, Demo TE

a H Demo Roster A User, Demo TE 04 1

O roster_123 User, Demo TE 09 1

a Test-2-23-23 User, Demo TE 04 1

O tts-test User, Demo TE 04 1

window for the roster opens (Figure 78). This form is similar to the form used to add students to
rosters. The Selected Students list displays students currently associated with the roster.
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Figure 78. Roster Manager Window: View/Edit Roster Form

View/Edit Demo Roster A

Search Results

Roster Details
Student's Last Name: LN; Student's First Name: FN; Enrolled Grade: 04

You can change the name and teacher associated with this roster.

A roster works best with about 30 students, although you can have up to 500 active students on each roster. *Roster Name: ‘ Demo Roster A ‘

*Teacher Name: | User, Demo TE v |
Available Students (124) Selected Students (3)
Filter students ‘ ‘ Show more information v ‘ Filter students
STUDENT NAME ENROLLED GRADE  SSID DATELEFT  ADD ALL + X REMOVEALL STUDENT NAME ENROLLED GRADE  SSID DATE LEFT
LN, FN 04 DEMO002470 + X LN, FN 04 DEMO002469
LN, FN 04 DEMO002472 + X LN, FN 04 DEMO002471
LN,FN 04 DEM002474 + X LN,FN 04 DEMO002473

5. To add students, select Find Students. Select the Student Search tab to add individual students
manually, or select the Quick Roster tab to add a group of students and then remove individual

students who do not need to be on the roster. After you return results, select
or select Add All from the top of the grid.

+ to add individuals

(] Note: Each user-defined roster can only be associated with one school, so the search options do

not include a way to search for a school.

6. Toremove students, click X next to an individual student or select Remove All from the top of

the grid.

7. Select Save, and in the affirmation dialog box select Continue.

Upload Classes (Rosters)

If you have many classes (rosters) to create, it may be easier to perform those transactions through file
uploads. This task requires familiarity with composing comma-separated value (CSV) files or working

with Microsoft Excel.

1. From the Features & Tools menu, select Upload Rosters. The Roster Manager window appears,

showing the Upload Rosters: Upload page (Figure 79).

71

Xipuaddy



Centralized Reporting System User Guide

Figure 79. Roster Manager Window: Upload Rosters: Upload Page

Upload Rosters

@ Use this page to upload a file to create rosters. /more info =

Upload
Find afile

Step 1: Upload File

Template

The format of your data is
important. Use a template to get
started.

Download Template

Drag & drop a file to upload History

View a history of uploads to this page.

Choose File
e o o o o R R M R M o

Next

Click Download Template on the right and select the appropriate file type.
Open the template file in a spreadsheet application, fill it out, and save it.

On the Upload Rosters: Upload page, click Choose File and select the file you created in the

previous step.

5. Click Next. The Upload Rosters: Preview page appears (Figure 80). Use the file preview on this page
to verify you uploaded the correct file.

Figure 80. Roster Manager Window: Upload Rosters: Preview Page

Upload Rosters

@ i the values in the columns do not match the headings in the table, use a template from the previous Upload Rosters page.

Upload Preview
Find afile Preview upload

Step 2: Preview

Check that you've uploaded the correct file. Only the first 10 rows display on the preview.

mostnse oot T
1

9999999999 9999999999-9959999990 (@test.user Sample 1
2 999999 9999 0 @test.user Sample 1
3 9999999999 9999999999-9999999990 (@test.user Sample 1
4 999999 -9999 0 @test.user Sample 1
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6. Click Next to validate the file.

Any errors or warnings are displayed on the Upload Rosters: Validate page (Figure 81). If a record
contains an error, that record will not be included in the upload. If a record contains a warning, that
record will be uploaded, but the field with the warning will be invalid.

Figure 81. Roster Manager Window: Upload Rosters: Validate Page

F

Upload Rosters

o o o

Upload Preview Validate eceive Confirmatior
Find afile Praview upload Fix emors

Step 3: Validate

@ 3 record(s) will be processed
0 1 record(s) with emars cannot be processed. To include these records, review the tables below. Then edit and upload your revised file

Summary
Shows an overview of issue types in your file with the number of times each issue occurs. Gives a solution for eech type when possible.

) Error: student 1D 1 not enralled In this School

Details

Shows the Record Mumber and column of each issue in vour file. Select the icons for information about each isswe. Note: Record Mumbers are one less than the row numbers for Excel
fils with column labels in the first row.

Digtrict Schioal 1D Emai adiress Rosler Name Student D Actian

Review the validation results below. |mane info -

— o
1

Usge 3 Student|D that 1s enrolled Inthe Schoal. [EmorCode700814)

L el 1999999399-2009900950 |;§::e sLuser Sample 1 e

| Upload Revised File ” Continue with Upload || Download Validation Report |

To revise the file before uploading, select Upload Revised File.
To view a list of issues with the file, select Download Validation Report.

To continue with the upload regardless of errors or warnings, select Continue with Upload. The
confirmation screen appears (Figure 82).

Figure 82. Upload Rosters Confirmation Page

Upload Rosters

© © © o

Upload Preview Validate Receive Confirmation
Find afile Preview upload Fix errors All done

v Your file has been uploaded.

@ 3 record(s) were processed.
€3 1 record(s) with errors were not processed.

Upload New File || Download Validation Report ” Download Rejected Records
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Table 1 provides the guidelines for filling out the Roster template that you can download from the
Upload Roster page.

Table 1. Columns in the Rosters Upload File

Element Description
District IRN* District associated with the
roster.
School IRN* School associated with the
roster.
Email* Email address of the user

*

Roster Name

SSID*

ACTION

*Required field.

associated with the roster.
Name of the roster.

Student’s unique statewide
student identifier.

Action column to add or delete
students from roster

Condition Codes

Valid Values

Six-digit District IRN that exists in
TIDE.

Six-digit School IRN that exists in
TIDE. Must be associated with the
district IRN.

Email address of a user existing in
TIDE.

Up to 20 characters.

Nine-digit identifier.

Add - adds student to roster

Delete - deletes student from
roster

Table 2 provides an overview of the various condition codes that may be entered for a machine- or
hand-scored item when a traditional score cannot be entered for the student’s response.

Source of
Code

Human

Human

Human

Human

Machine

Machine

Table 2. Condition Codes

Condition Description
Code

Blank e The student did not enter a response.

Unreadable e The response is unreadable. For example, an online response
is unreadable if it only contains repeated/random keystrokes
(e.g., “vyyyyyyyyyy”; “av:aeoiahvb;e”; “hhrrttuuvv”).

Foreign e The response is written in a language other than English.

Language

Off Topic ¢ Student writes to a subject that is unrelated to the prompt.

Blank e The student did not enter a response.

Insufficient Text e The response is substantially comprised of repeated text

(Repetitive Text) copied over and over.
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Source of Condition Description
Code Code

Machine Insufficient Text The response contains too few words to be deemed adequate
(Too Few to be scored.
Words)

Machine Insufficient Text The response is composed of a significant amount of text
(Insufficient copied directly from the prompt and/or reading passage, with
Original Text) little to no original writing from the student.

Machine Non-Specific This condition code is assigned to machine-scored responses
when TDS identifies that the response requires a condition
code but cannot determine which specific condition code it
requires. Resolution is required.

Machine Non-Scorable This condition code is assigned to machine-scored responses

H
Help

Language when TDS identifies that the response contains primarily
(Uninterpretable atypical or unusual words and is unable to assign a score.
Language) Resolution is required.

The Reporting System includes an online user guide.

Access the Online User Guide

In the banner, click Help. The guide opens in a pop-up window, showing the help page specific to the
page you're on. For example, if you click Help while on the dashboard, you’ll see the Overview of the
Dashboard page.

L

Login Process

This section describes how to log in to the Reporting System.

Do not share your login information with anyone. All Ohio Assessment systems provide access to
student information, which must be protected in accordance with federal privacy laws.

Log In to the Reporting System
1. Navigate to the test portal.

2. Select your user role from the cards displayed (Figure 83).
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Figure 83. User Role Card

1

Teachers and Test Administrators

Access systems used before, during and after
testing and review key resources.

3. Click the Centralized Reporting System (CRS) card (Figure 84). The login page appears.

Figure 84. Reporting Card

SYSTEM

-?\

Access and download state Assessments
results and view reports on student
performance.

4. Onthe login page (Figure 85), enter the email address and password you use to access all CAl
systems.

Figure 85. Login Page

Login
Please Log In
Enter your username and password to log into AIR Assessment
online systems_ Once you log in, you will automatically be directed Email Address
1o your selected system.
Need More Help? m P

assword

If you forgot your password or need a new password, please
use the Forgot Your Password link to reset it Forgot Your Password?

For assistance, contact the WV Help Desk at 1-844-560-7367 | S Logi
wvhelpdesk@air.org ecure Login

First Time Login This School
Year?

The password you used during the previous
school year has expired.

Request a new one for this school year.

5. Click Secure Login.
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a. If the Enter Code page appears (Figure 86), an authentication code is automatically sent to
your email address. You must enter this code in the Enter Emailed Code field and click
Submit within 15 minutes.

- If the authentication code has expired, click Resend Code to request a new code.

Figure 86. Enter Code Page

Enter Code

< A code has been sent to your email address. The code
will expire after 15 minutes

B Enter Emailed Code

Resend Code

Cancel

b. If your account is associated with multiple institutions, you are prompted to select a role, as
in Figure 87. From the Role drop-down list, select the role and institution combination you
wish to use. You can also change your institution after logging in.

Figure 87. Select Role Window

Select Role

Please select the role you wish to use.

Role: DTC @ District: zzz Cambium Training District v

The Dashboard Generator for your user role appears.

Set or Reset Your Password

Your username is the email address associated with your account in TIDE. When you are added to TIDE,
you receive an activation email containing a temporary link to the Reset Your Password page
(Figure 88). To activate your account, you must set your password within 15 minutes.

All users are required to do a one-time password reset at the beginning of every school year, for security
purposes.
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If your first temporary link expired:

In the activation email you received, click the second link provided and request a new
temporary link.

If you forgot your password:

On the Login page, click Forgot Your Password? and enter your email address in the E-mail Address
field. Click Submit. You will receive an email with a new temporary link to reset your password.

Figure 88. Reset Your Password Page

Reset Your Password

Reset Your Password
Enter your email address and select Submit. You will receive an
email that contains a link to create a new password. B E-mail Address

Need More Help?

I1you Torgot your pAsSWord or need a new password, please “

use the Forgot Your Password link to reset it
Return fo Login Page

For assistance, contact the WV Help Desk at 1-844-560-7367

urvhelpdesk@air org

If you did not receive an email containing a temporary link or authentication code:

Check your spam folder to make sure your email program did not categorize it as junk mail. If you
still do not see an email, contact your Building or District Test Coordinator to make sure you are
listed in TIDE.

Additional help:

If you are unable to log in, contact the Ohio Help Desk for assistance. You must provide your name
and email address.
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M
Multiple Test Opportunities

Sometimes test results will include multiple rows for the same student.

When a student completes multiple test opportunities for a single assessment, as in Figure 89, reports

display a row of data for each opportunity. A clock icon appears next to the most recent
opportunity. Previous opportunities are marked with numbers (1}, starting from the earliest test taken.

An asterisk icon indicates that an opportunity is not the most recent and therefore is not included in
calculations of average scores or performance distributions.

Figure 89. School Performance on Test Report: Performance by Student Tab

Select Bole * Dshtoan Genwealer > Danhboard * Prrformance on Tests * Cistrict Performance on Test » School Petformance an Test * Roster Perfommencs on Tew! L+
~
E'E Scof, Performance and Poirts Eamed on Grade 5 ELA - Performance Tesk - Whales (LAB) (Test One} of (siudents not in sy rester). by Siudent and Reponing Category: 20277023 i Faitorsi A T
Fiwa | ey Eoheet AN Gown | Tewl Resse: Test e | Bl Keys S sl
@ e+ e o S o
traiardn B E v Burmibairs, M Pints and Porits Darmad
E 1 [ 2 4 [ 1 (4
Pertamance
soEzsEwss @ ACEY S WSS [] ACRUSWE [] TEASEN TS (]
I 1pt pt &t
= w
E P— ™y ‘o 187 a
T ™
| FRaaiaa g
L - = ! ]
[, 1o
rd 2 L]

o EATE A b Standard
1 [ e M Flanded 2 g 2 0 ]

sorm o mmmans sm . cncrranss B ros s e o

Most Recent Assessment # Opportunity is not included in calculations of average scores and performance levels Fowrd Dot page 2 Imems ioe2 B

N

Non-Scorable Test Opportunities

The reports in Reporting do not include data for non-scorable test opportunities. A student’s test
opportunity cannot be scored when it has a test status of “Expired” or “Invalidated.” If a test
opportunity is non-scorable, a notification A appears below the report for that assessment.

You can click More Info on the notification to view the Students with Other Test Statuses window. This

window lists the students who have non-scorable test opportunities for the given assessment, as well as
the status code and completion date for each.
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P

Performance Data

Depending on the test, a report may display different kinds of performance data:

e Score data:

e Scale scores.
e Raw scores, which may be in the form of percentages or fractions.

e Performance level data, which are used for tests with performance levels. Performance levels
provide qualitative measurements of students’ proficiency in relation to a particular standard or set
of standards. Some aggregate reports include performance distribution bars, as in Figure 90,
showing the percentage and number of students who achieved each performance level. These bars
are color-coded, with three performance levels being coded red-yellow-green, four being coded red-
yellow-green-blue, and five being coded red-yellow-green-blue-purple.

e Percent proficient, also shown in some aggregate reports (Figure 90), represents the total
percentage of students who achieved proficiency. It typically includes those who fell into the top
one to three performance levels.

Figure 90. Teacher User View: My Students; Performance on Test Report: Performance by Roster Tab

Select Role > Dashboard Generalor > Dashboard > Performance on Tests > My Students' Performance on Test Enter Student ID Q
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A legend appears (Figure 91), explaining what the scores or performance levels indicate.
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Figure 91. School Performance on Test Report with Expanded Performance Distribution Legend
Select Role » Dashboard Generator > Dashboard » Performance on Tests * School Performance on Test Enter Student ID Q
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A student with a score of Limited can solve simple linear equations and
inequalities, create and graph simple linear functions, transform basic
geometric figures, and describe how the mean and median of two data sets
Tech-LN, Tech-FN DEMO/ compare. Yes
[ %Basic (682-699):

A student with a score of Basic can create and solve simple linear equations

and inequalities in one or two variables, recognize exponential functions,
TechiN, TechFN DEMO. identify congruent triangles, and interpret key features of scatter plots.

[ Proficient (700-724):
A student with a score of Proficient can solve multi-step linear equations,
interpret key features of functions, use transformations to determine Rowsperpage: 2 O 1000 Items: 1 of500 >
congruence of geometric figures, and compare data in tables or graphs.

. %Accomplished (725-753):
A student with a score of Accomplished can interpret the structure of

expressions to rewrite them in multiple forms, interpret graphs in context,
justify congruence of figures, and interpret data displays in context.

Il %advanced (754-814):

You will find similar buttons @@ in reports throughout the Reporting System.

R

Report Tables
Sort a Table

1. To sort by descending order, click the header of the column you wish to sort by. The bottom arrow

in the header is shaded darker ¥ when the column is sorted in descending order.
2. To sort by ascending order, click the column header again. The top arrow in the header is shaded

A
darker when the column is sorted in ascending order.

Specify the Number of Rows Displayed

In the Rows per page field below a table, enter the number of rows you want the table to display per
page. Your specifications persist for each table.

You can click the arrow buttons in this field to increase or decrease the number of rows displayed in
increments of one.
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View Additional Table Rows

e To move to the next and previous pages in a table, click the arrow buttons ) ( at the lower-right
corner of the table.

e To jump to a specific table page, enter the page number in the field 1] atthe lower-right corner of
the table.

View Additional Table Columns

To scroll the table to the right or left, click the arrow buttons @@ on the right and left sides of the

table. Alternatively, click and drag the horizontal scrollbar at the bottom of the table.

If a table contains expandable and collapsible accordion sections, you can click the section bars expand
and collapse them.

Expand All Accordion Sections in a Table

If you’re navigating the page by tabbing through it, you may want to expand all the expandable
accordion sections of a table at once. This feature, which is available in most test results, will make the
table accessible to a screen reader.

1. Navigate to the table by tabbing through the page in your browser. When the “Load Accessible
Table” message appears, press the Enter key. All the accordion sections expand.

2. Optional: To collapse the sections again, navigate back to the table. When the “Hide Accessible
Table” message appears, press the Enter key. All the accordion sections collapse, except the Total
section.

Secure File Center

The Reporting System allows you to access a Secure File Center that is integrated with other online
assessment systems, such as TIDE, and accessible from the test portal. The Secure File Center serves as a
central repository for secure documents that have been externally uploaded to the Secure File Center
and that you have privileges to view, files shared between users, files exported by users and automated
child alerts.

Each user’s Secure File Center is personal to them and not shared among other users. Users can easily
manage the files in their Secure File Centers. The files are categorized into different tabs to allow users
to view non-archived and archived files. Users can also search for files by keyword. Files are listed in the
order in which they were created. The file creation and file expiration dates appear, if applicable, and
the number of days remaining until a file expires is also displayed. Users can archive or delete files as
needed. Users can also share files by sending them to other users’ Secure File Centers.

Access and Manage Files in the Secure File Center

The files in the Secure File Center are listed in the order in which they were created. The file creation
and file expiration dates appear, if applicable. The number of days remaining until a file expires is also
displayed next to a file. By default, exported files are available for 30 days. You can access the Secure
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File Center from any page in Reporting to either download the file or archive the file. You can also delete
the files you have exported, but not files added by admin users.

1.

In the banner, click Secure File Center. The Secure File Center window appears (Figure 92). By
default, the Secure File Center displays the View Documents tab.

Figure 92. Secure File Center Window: View Documents Tab: Recent Sub-Tab

Secure File Center

Secure File Genter £ et
Recent Archived
=y
o I T
TIDE

Reporting 07/18/202309:53  08/17/2023 09:53
2 _StudentiSRs_095328175 AM.pcf |Reporting M A
A Custom Labels
06/26/2023 12:31  07/26/2023 12:31 = =
O 1 RostersAtDemo School 1.csv | TIDE PM PM O
. 06/26/2023 12:30  07/26/2023 12:30 = =
O 2 UsersatDemo District 1.xisx [TIDE oM - - O

Choose either of the available tabs (Figure 92):
= Recent: Displays all files except those that have been archived.
= Archived: Displays files that have been archived.
Optional: To filter the files displayed, enter a search term in the text box in the upper-right corner.
Optional: To hide or display system labels, click the System Labels toggle.
Optional: To hide files with a particular system label, clear the checkbox for that label.
Optional: To hide or display custom labels, click the Custom Labels toggle.
Optional: To hide files with a particular custom label, clear the checkbox for that label.
Optional: Do one of the following:

= To download a file, click the name of the file.

= To add a new custom label or apply an existing custom label, select .

- To apply a new custom label, mark the checkbox, enter a new custom label in the text
box, and select Save New Label.

- To apply an existing custom label, mark the checkbox, enter an existing custom label in
the text box, and select Apply Label.

=  To archive a file, select . To unarchive a file from the Archived tab, select @
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= To delete afile, select D Files exported to the Secure File Center or archived can be
deleted. However, secure documents uploaded to the Secure File Center by admin users
cannot be deleted.

Send Files to Other Users’ Secure File Centers

1.

From the banner, select Secure File Center. The Secure File Center page appears. By default, the
View Documents tab displays.

Select the Send Files tab. The Send Files page appears (Figure 93).
In the Select Recipients field, do one of the following:
= Select Role to send a file or files to a group of users by user role.
= Select Email to send a file or files to a single recipient by email address.

e If you select Email, skip to step 7.

Figure 93. Secure File Center Window: Send Files Tab

Secure File Center

‘ Secure File Center [0 View Documents B Send Files -

Select Recipients

ORele O Email

Select Role(s)

O stateroles O Districtroles O School roles

v Select Organization(s)

Add File

Browse

0 of 10 documents

* By clicking Send, you agree that Cambium Assessment cannot be held liable for data shared as a result of sending these files.

In the Select Role(s) field, select the role group to which you want to send a file or files. A drop-down
list appears.

From the drop-down list, select the role(s) to which you want to send a file or files. You can choose
Select all to send a file or files to all roles in the selected role group.

84

Xipuaddy



Centralized Reporting System User Guide

6. From the Select Organization(s) drop-down lists, select organizations that will receive the file(s) you
send. These drop-down lists adhere to the user role hierarchy. For example, district-level users will
be able to filter at their role level and below.

7. If you selected Role in step 3, skip this step. If you selected Email in step 3, enter the email address
of the recipient to whom you wish to send a file or files.

8. To select a file or files to send, in the Add File field, select Browse. A file browser appears.
9. Select the file(s) you wish to send.
10. Select Send.

Files display in the Secure File Center after you send them.

T

Test Resources
Some test results in the Reporting System include supplementary information that you can access, such

as resources provided for the assessment in Tools for Teachers.

If additional assessment information is available, click the Get Instructional Resources button in the
Features & Tools menu.

A window opens (Figure 94), displaying resource links that either download or open in a new browser
tab or window.

Figure 94. Test Resources Window
Test Resources u
Test Resources for Module: Math Grade 3 - Measurement Data and Geometry A
Resource Description

Mmgﬁ' For guidance on reviewing and interpreting student score information in AIRWays for

SEArEs 10 Interim Medule Assessments, please refer to the information in this Quick Guide

U
User Role Change

If your account is associated with multiple user roles or institutions, you can switch between them at
any time to view the dashboard and reports for your other roles and institutions. The following
instructions do not apply to switching schools for hand scoring purposes.
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1. From the banner menu, select Change Role. (Alternatively, click the Select Role link in the path at
the upper-left corner.) The Change Role window appears.

2. From the Role drop-down list, select the desired role and institution (entity name) combination.

3. Click Continue. The window closes and the Dashboard Generator page appears.
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User Support

For additional information and assistance in using the Reporting System, contact the Ohio Help Desk.

The Ohio Help Desk is open 7 a.m. to 5 p.m. Eastern Time (except holidays or as otherwise indicated on
the Ohio Assessments Portals).

~

Ohio Assessment Help Desk
Toll-Free Phone Support: 1-877-231-7809
Email Support: OHHelpDesk@cambiumassessment.com

Please provide the Ohio Help Desk with a detailed description of your problem, as well as the following:
e If the issue pertains to a student, provide the student’s SSID and associated district or school. Do not
provide the student’s name.

o If the issue pertains to a Test Information Distribution Engine (TIDE) user, provide the user’s full
name and email address.

e Any error messages and codes that appeared, if applicable.

e QOperating system and browser information, including version numbers (for example, Windows 11
(21H2) and Firefox 113 or macOS 13.3 and Safari 16).
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Change Log

Location Change Date
Throughout Initial 2023-2024 Version 8/2/2023
Use the Dashboard Added mentions of field-authored (Assessment 2/7/2024
Generator Page Authoring-created) tests.

Teachers and School- Split this into two consecutive sections. “Teachers” 2/7/2024
Level Users: View section now focuses on teacher-level reports and does
Student-Level Data for All | not include school-level ones. “School-Level” does the
Your Students opposite.
View a Cross-Sectional New section that describes the new Cross-Sectional 2/7/2024
Report Report type now available.
View and Interpret Writing | Edits to reflect updated writing dimension score 2/7/2024
Dimension Measures reporting. Includes:
Addition of aggregate score point counts
Addition of student level data
Access Test Results for Edits to mention more sections, including Writing 2/7/12024
an Individual Student on Dimensions, that may appear in some reports.
a Particular Test
View Data from a Edits to clarify how the date setting works. 3/26/2024
Previous Point in Time
e Score Unscored Items | Edits to clarify what happens to scoring notes. 3/26/2024
e Submit Scored Test
Opportunities for
Processing
¢ Modify Scores for
Iltems in Reports
e Generate and Export Additional text and new screenshots for the new 3/26/2024

Individual Student
Reports (ISR)

e Generate and Export
Student Data Files

checkbox in the Student Results Generator that allows
the user to include students who were associated with
them at the time of testing.
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